Question 1
Which feature on Cisco Unified CME provides one-way automatic path communication for emergency notifications?
A. c-barge
B. blind transfer
C. intercom
D. paging
E. directed pick-up
Correct Answer: D
Explanation/Reference:

Question 2
What is the maximum number of digits that an ephone PIN can have to allow after-hour exempt calling privileges?
A. 4
B. 6
C. 7
D. 8
E. 9
Correct Answer: D
Explanation/Reference:

Question 3
Which three methods can remotely force a Cisco Unified Communications Manager Express phone to reset? (Choose three.)
A. Issue a shutdown, no shutdown command on a switch port that provides PoE to a Cisco phone.
B. Issue the restart command under the ephone-dn configuration of the phone.
C. Issue the reset command under the ephone configuration of the phone.
D. Issue the reset command under the ephone-dn configuration of the phone.
E. Issue the reset H.H.H (mac-address) command telephony-service configuration.
F. Issue the reset H.H.H (mac-address) command under global configuration.
Correct Answer: ACE
Explanation/Reference:

Question 4
When you reset an IP phone via the Cisco Unified Communications Manager Administration page, which method briefly shuts down a registered phone and brings it back up?
A. drop
B. restart
C. reset
D. shutdown
E. shut and no shut
Correct Answer: C
Explanation/Reference:

Question 5
Which option is the default packetization interval on Cisco ISR routers?
A. 10 msec
B. 20 msec
C. 30 msec
D. 40 msec
Correct Answer: B
Explanation/Reference:
Question 6
Which Cisco Unity Express web administration menu contains the functionality for a voice administrator to change a user PIN?
A. Configure
B. System
C. Voicemail
D. Administration

Correct Answer: A
Explanation/Reference:

Question 7
Which submenu does an administrator select to unlock the pin?
An end user has made more attempts to log in than allowed, using the wrong voice-mail pin. The user has been locked out. Which submenu does an administrator select to unlock the pin?
A. change password
B. password settings
C. message settings
D. mailbox

Correct Answer: B
Explanation/Reference:

Question 8
Which default code on Cisco IP phones is used to unlock the manual configuration of items such as network configuration settings?

Correct Answer: D
Explanation/Reference:

Question 9
Which procedure allows the leading digits to be stripped as soon as they arrive at the H.323 voice gateway?
Customer requirements dictate that local calls from area code 408 display the ANI as a 7-digit number. Which procedure allows the leading digits to be stripped as soon as they arrive at the H.323 voice gateway?
A. Set up a voice translation rule, apply the translation rule to a translation profile, and apply the translation profile to the dial peer in the inbound direction.
B. Set up a voice translation profile, apply the translation profile to a translation rule, and apply the translation rule to the dial peer in the outbound direction.
C. Set up a voice translation rule, apply the translation rule to a translation profile, and apply the translation profile to the dial peer in the outbound direction.
D. Set up a voice translation profile, apply the translation profile to a translation rule, and apply the translation rule to the dial peer in the inbound direction.

Correct Answer: A
Explanation/Reference:

Question 10
Which Cisco Unified Communications Manager configuration causes an IP phone screen to display a “registration rejected” message?
Which Cisco Unified Communications Manager configuration causes an IP phone screen to display a “registration rejected” message?
A. Cisco Unified Communications Manager is unable to reach user IP phone.
B. Cisco Unified Communications Manager database replication status is 2.
C. Cisco Unified Communications Manager auto registration is disabled.
D. Cisco Unified Communications Manager is unable to allocate DN.
E. Cisco Unified Communications Manager subscriber is offline.

Correct Answer: D
Explanation/Reference:

Question 11
Which configuration causes PSTN users to experience a fail tone for every other call when trying to reach a particular number on Cisco Unified CME?
Which configuration causes PSTN users to experience a fail tone for every other call when trying to reach a particular number on Cisco Unified CME?
A. ephone-dn is not assigned to the ephone.
B. Duplicate ephone-dn is not assigned to the ephone.
C. ephone is not registered.
D. ephone does not exist for the ephone-dn.

Correct Answer: B
Explanation/Reference:
Question 12
Which command resolves the issue?
Refer to the exhibit.
A voice engineer is investigating call routing to an office with phone number 5551000 because callers hear dial tone as soon as calls into the office connect. An H.323 gateway forwards calls to a Cisco Unified Communications Manager at IP 192.168.17.15. The running configuration shown in the exhibit is seen upon investigation into the dial peers. Which command resolves the issue?
A. direct-inward-dial in dial-peer voice 1 pots configuration
B. incoming called-number in dial-peer voice 1 voip configuration
C. direct-inward-dial in dial-peer voice 1 voip configuration
D. session-target ipv4: 192.168.17.15 in dial-peer 1 voice pots configuration
Correct Answer: A
Explanation/Reference:

Question 13
Which action is next in the Cisco Unified Communications Manager to back up manually to the laptop?
Cisco Unified Communications Manager is configured to complete scheduled backups to a SFTP server. The voice engineer wants to manually back up to a laptop that has SFTP server configured. Which action is next in the Cisco Unified Communications Manager to back up manually to the laptop?
A. Select network directory on the backup device.
B. Create a backup device.
C. Schedule the backup.
D. Create a dedicated backup directory.
Correct Answer: B
Explanation/Reference:

Question 14
Which server’s IP address does the engineer enter when RTMT is starting?
A voice engineer is using RTMT to monitor voice-mail usage. Which server’s IP address does the engineer enter when RTMT is starting?
A. Cisco Unified Communications Manager publisher
B. Cisco Unified Presence Server subscriber
C. Cisco Unity Connection publisher
D. Cisco Unified Communications Manager subscriber
Correct Answer: C
Explanation/Reference:

Question 15
Which step is next after navigating to Cisco Unified Reporting?
A voice engineer wants to monitor system activities using the RTMT tool. Which step is next after navigating to Cisco Unified Reporting?
A. system > scheduler > CDR
B. system reports > unified CM data summary > generate report
C. system > tools > reports
D. tools > CDR analysis and reporting
Correct Answer: B
Explanation/Reference:

Question 16
Which Cisco Unified Communications Manager device report provides key information to determine if an additional gateway is needed?
Which Cisco Unified Communications Manager device report provides key information to determine if an additional gateway is needed?
A. gateway utilization
B. gateway summary
C. gateway detail
D. gateway and line group utilization
Correct Answer: A
Explanation/Reference:

Question 17
Which Cisco Unified Communications Manager system report shows high and low call volume patterns?
Which Cisco Unified Communications Manager system report shows high and low call volume patterns?
A. CAR report
B. QoS by Gateway
C. QoS by call types
D. traffic summary
E. traffic summary by extension
Correct Answer: D
Explanation/Reference:

Question 18
How fast can Cisco Unified Communications Manager generate CDR and CMR files?
How fast can Cisco Unified Communications Manager generate CDR and CMR files?
A. one CDR file and one CMR file every second for up to 1 minute
B. one CDR file and one CMR file every minute for up to 1 hour
C. ten CDR files and ten CMR files every hour for up to 1 day
D. ten CDR files and ten CMR files every day for up to 1 week

Correct Answer: C
Explanation/Reference:

Question 19
When should this device be configured?
Refer to the exhibit.

The exhibit shows a partial screen shot for a Cisco Unified Personal Communicator device. When should this device be configured?
A. when configuring the Service Advertisement Framework feature for Call Control Discovery
B. when Cisco Unified Personal Communicator is used in desk-phone mode
C. when Cisco Unified Personal Communicator version 7.0 is used in soft-phone mode
D. when Cisco Unified Personal Communicator version 8.0 is used in soft-phone mode
E. when Cisco Unified Personal Communicator version 8.0 is used in desk-phone mode

Correct Answer: C
Explanation/Reference:

Question 20
Which options are two on-premise components of Cisco Unified Presence?
Which options are two on-premise components of Cisco Unified Presence? (Choose two.)
A. Cisco Unified Communication Manager
B. Cisco Unified Contact Center Express
C. Cisco WebEx
D. Cisco Quality Management
E. Cisco Unified Contact Center Enterprise

Correct Answer: AC
Explanation/Reference:

Question 21
How many servers can be supported in a Cisco Unified Presence Server cluster environment?
How many servers can be supported in a Cisco Unified Presence Server cluster environment?
A. 2
B. 4
C. 6
D. 8
E. 10

Correct Answer: C
Explanation/Reference:

Question 22
Which three reasons would a voice engineer create a separate user template in Cisco Unity Connection?
For which three reasons would a voice engineer create a separate user template in Cisco Unity Connection? (Choose three.)
A. Certain users changed their extensions.
B. Certain users are in a different partition.
C. Certain users are using a different call handler.
D. Certain users are using a different phone system.
E. Certain users are being added to Cisco Unified Presence Server.
F. Certain users are being moved to a different branch office.

Correct Answer: BCD
Question 23
Which two settings must be updated in Cisco Unified Communications Manager to successfully update the Cisco Unity Connection?
- A voice engineer is updating a user extension in Cisco Unity Connection using the Sync Users option. Which two settings must be updated in Cisco Unified Communications Manager to successfully update the Cisco Unity Connection? (Choose two.)
  A. user IP phone firmware
  B. primary extension on the user device
  C. primary MAC address of the IP phone
  D. primary extension in the user profile
  E. UC profile in the user profile
  F. soft key template on the user device

Correct Answer: BD

Explanation/Reference:

Question 24
Which submenu does the administrator select to reset the user credentials?
An end user is unable to log in to a voice-mail box. Which submenu does the administrator select to reset the user credentials?
- A. change password
- B. password settings
- C. user settings
- D. custom recordings
- E. mailbox

Correct Answer: A

Explanation/Reference:

Question 25
Which three choices does a network engineer have when adding a mailbox in Cisco Unity Connection?
Which three choices does a network engineer have when adding a mailbox in Cisco Unity Connection? (Choose three.)
- A. Import a user from Cisco Unified Communications Manager.
- B. Create a new user in Cisco Unity Connection.
- C. Import a user from Cisco Unified Presence Server.
- D. Import a user from LDAP directory.
- E. Create a user template.
- F. Add a new user from Outlook

Correct Answer: ABD

Explanation/Reference:

Question 26
Which type of template should be used when a network engineer adds a new call center agent in the Cisco Unity Connection?
Which type of template should be used when a network engineer adds a new call center agent in the Cisco Unity Connection?
- A. contact
- B. call handler
- C. user
- D. notification

Correct Answer: C

Explanation/Reference:

Question 27
Which two user types are available to a voice engineer adding a user in Cisco Unity Connection?
Which two user types are available to a voice engineer adding a user in Cisco Unity Connection? (Choose two.)
- A. user with mailbox
- B. imported user
- C. synch user
- D. user without mailbox
- E. local admin user with mailbox

Correct Answer: AD

Explanation/Reference:

Question 28
Which Cisco Unified Communications Manager Express configuration command changes the order of the name directory?
The manager wants to see the user’s last name first when using the Directory button on a Cisco IP phone. Which Cisco Unified Communications Manager Express configuration command changes the order of the name directory?
- A. directory last-name-first in telephony-service configuration
- B. directory first-name-last in telephony-service configuration
- C. directory last-name-first in ephone-dn configuration
- D. directory first-name-last in ephone-dn configuration

Correct Answer: A
Question 29
Which profile must be added to the end user profile when enabling an end user for Cisco Unified Presence?
A. device profile
B. UC service profile
C. extension mobility profile
D. SIP profile
Correct Answer: B

Question 30
Which IOS configuration on the Cisco Unified Communications ManagerExpress router must the voice administrator perform to fulfill this request?
A customer requests that a 7960 IP phone that is registered to a Cisco Unified Communications Manager Express enabled router be configured so that the line display name on the phone shows OFFICE PHONE instead of 5005. Which IOS configuration on the Cisco Unified Communications ManagerExpress router must the voice administrator perform to fulfill this request?
A. ephone-dn 6 number 5005 label OFFICE PHONE description x5005 caller-id 5005
B. ephone-dn 6 number 5005 description OFFICE PHONE caller-id OFFICE PHONE
C. ephone-dn 6 number 5005 dn-label OFFICE PHONE caller-id 5005
D. ephone-dn 6 number 5005 line-label OFFICE PHONE caller-id 5005 line-description OFFICE PHONE
Correct Answer: A

Question 31
Which command does a voice administrator use to program ephone 1 to have extension 1000?
Refer to the exhibit

```
ephone 1
mac-address 0014.1c48.e71a
ephone-dn 1
number 1000
```
Which command does a voice administrator use to program ephone 1 to have extension 1000?
A. command button 1:1 under ephone-dn 1 configuration
B. command number 1:1 under ephone-dn 1 configuration
C. command number 1:1 under ephone 1 configuration
D. command button 1:1 under ephone 1 configuration
Correct Answer: D

Question 32
Which step is next in the troubleshooting process?
A user has been placing international phone calls even though it should be prohibited by local policy. Route partitions have dependency records that point to route patterns that do not include international dialing route patterns. Which step is next in the troubleshooting process?
A. Remove the device pool and reconfigure it in Cisco Unified Communications Manager.
B. Check for a Calling Search Space at the device level to see if it has the correct route partitions associated to it.
C. Check for a Calling Search Space at the line level to see if it has the correct route partitions associated to it.
D. Reconfigure the device pool-based Calling Search Space to be reassigned to the route partitions.
Correct Answer: B

Question 33
Which menu option is the last that a voice administrator will use to modify the Caller ID name of a Cisco Unified Communications Manager Expressphone using Cisco Configuration Professional?
Which menu option is the last that a voice administrator will use to modify the Caller ID name of a Cisco Unified Communications Manager Expressphone using Cisco Configuration Professional?
A. user settings
B. extensions
C. phones
D. directory services
Correct Answer: A

Question 34
Which application should be selected in the navigation pane to add an endpoint in Cisco Unified Communications Manager?
A. Cisco Unified Serviceability
B. Cisco Unified CM Administration
C. Cisco Unified OS Administration
D. Cisco Unified Reporting

Correct Answer: B
Explanation/Reference:

Question 35
Which menu should be used to create a username and password in the Cisco Unified CME GUI?
A. configure > pilot number
B. configure > extension
C. configure > phones
D. configure > system parameters

Correct Answer: C
Explanation/Reference:

Question 36
Which two inputs are needed to create a new user profile in Cisco Unified Communications Manager? (Choose two.)
A. user ID
B. user password
C. first name
D. last name
E. telephone number

Correct Answer: AD
Explanation/Reference:

Question 37
Which includes the Standard CCMADMIN Administration role, but the user cannot add new users. What is the cause of this issue?
A. The add user capability has been disabled for the group.
B. The incorrect group and role were assigned.
C. The add user capability has been disabled for the role.
D. Only the CCMAdmin user can add users.
E. Users can be added only via LDAP.

Correct Answer: B
Explanation/Reference:

Question 38
Which telephony-service command adds extension 100, John Doe, as the first entry in the corporate directory of Cisco Unified CME?
A. directory entry 1 100 name John Doe
B. corporate-directory entry 1 100 name John Doe
C. directory entry 1 100 first-name John last-name Doe
D. corporate-directory entry 1 100 first-name John last-name Doe

Correct Answer: A
Explanation/Reference:

Question 39
Which three information fields must be entered when adding a user in Cisco Unified CME? (Choose three.)
A. mac address of device
B. username
C. phone type
D. password
E. pin
F. device security mode
G. ephone-dn

Correct Answer: BDE
Explanation/Reference:

Question 40
Which action ensures prioritization of voice over data traffic?
A. voice and data VLAN on different subnets with QoS classification
B. voice and data VLAN on same subnets without QoS classification
C. signaling and media traffic marked with Layer 2 CoS and Layer 3 DSCP mappings
D. signaling and media traffic marked with Layer 2 DSCP and Layer 3 CoS mappings

Correct Answer: C
Explanation/Reference:

Question 41
Which three information fields must be entered when adding a user in Cisco Unified CME? (Choose three.)
A. mac address of device
B. username
C. phone type
D. password
E. pin
F. device security mode
G. ephone-dn

Correct Answer: A
Explanation/Reference:

Question 42
Which action ensures prioritization of voice over data traffic?
A. voice and data VLAN on different subnets with QoS classification
B. voice and data VLAN on same subnets without QoS classification
C. signaling and media traffic marked with Layer 2 DSCP and Layer 3 DSCP mappings
D. signaling and media traffic marked with Layer 2 DSCP and Layer 3 CoS mappings

Correct Answer: C
Explanation/Reference:

Question 43
Which protocol is used to monitor active voice call quality?
A. RTCP
B. RTP
C. QoS
D. STP
E. SDP

Correct Answer: A
Explanation/Reference:

Question 44
Which two features are provided by Cisco Unified Communication Manager Express? (Choose two.)
A. call processing and device control
B. voice-mail service
C. cluster capability for backup
D. backup service for recovery
E. active directory integration

Correct Answer: AB
Explanation/Reference:

Question 45
Which two peer-to-peer protocols can be used to set up signaling between an IP phone and call controller? (Choose two.)
A. MGCP
B. SIP
C. H.225
D. SDP
E. H.323
F. RTP

Correct Answer: BE
Explanation/Reference:

Question 46
Which command allows the telephony service of a Cisco Unified Communications Manager Express router to be associated to loopback address 192.168.143.44?
A. telephony-servicemax-ephones 4max-dn 8ip source-address 192.168.143.44!
B. telephony-servicemax-ephones 4max-dn 8ip bind src-addr 192.168.143.44!
C. `telephony-servicemax-ephones 4max-dn 8source-address ipv4: 192.168.143.44`
D. `telephony-servicemax-ephones 4max-dn 8ip address 192.168.143.44`

Correct Answer: A
Explanation/Reference:

**Question 47**
Which two Cisco Unified Communications products allow for CSS creation?
Which two Cisco Unified Communications products allow for CSS creation? (Choose two.)
A. Cisco Unified Presence
B. Cisco Unified Contact Center Express
C. Cisco Unified Communications Manager
D. Cisco Emergency Responder
E. Cisco Unity Connection

Correct Answer: CE
Explanation/Reference:

**Question 48**
How would the user access the extension mobility login screen?
Your Cisco Unified Communications Manager system has extension mobility enabled for users of Cisco Unified Wireless IP Phone 7925 handsets and its working properly. How would the user access the extension mobility login screen?
A. Extension mobility is not available on wireless handsets.
B. Power on the phone, and extension mobility automatically starts.
C. Power on the phone, and navigate to System Options > Extension Mobility.
D. Power on the phone, and navigate to Web Services > Extension Mobility.

Correct Answer: D
Explanation/Reference:

**Question 49**
What needs to be done on Cisco Unified CME for the call park softkey to appear on the IP phone screen?
You successfully added a call park feature for the IP phone that is registered with Cisco Unified Communications Manager Express. What needs to be done on Cisco Unified CME for the call park softkey to appear on the IP phone screen?
A. Restart the IP phone.
B. You do not need to do anything. It will appear once the configuration is done.
C. You cannot add the call park feature to an existing configured IP phone. You have to delete the IP phone configuration first, and then start configuring it again.
D. The call park feature is not supported on Cisco Unified CME.

Correct Answer: A
Explanation/Reference:

**Question 50**
What tool is provided by Cisco Unity to actively, semi-intrusively monitor Unity system performance?
What tool is provided by Cisco Unity to actively, semi-intrusively monitor Unity system performance?
A. Cisco Unity Performance Information and Diagnostics
B. Cisco Unity Disaster Recovery Tools
C. Microsoft Management Console
D. Microsoft Windows Performance Monitor

Correct Answer: A
Explanation/Reference:

**Question 51**
What Cisco Unity Connection option should you configure to resolve the problem?
Refer to the exhibit.
You modify the primary extension of a Cisco Unified Communications Manager user, but shortly afterwards the user complains that although she can access her mailbox, her IP phone is not receiving new voice message notifications. What Cisco Unity Connection option should you configure to resolve the problem?
A. Edit User Basics > Extension
B. Edit User Basics > Alternate Extension
C. Edit User Basics > Message Waiting Indicators
D. Edit User Basics > Message Actions
Correct Answer: A
Explanation/Reference:

**Question 52**
Which choice should be checked first to isolate the issue?
A Cisco IP phone fails to register with the Cisco CallManager. Which choice should be checked first to isolate the issue?
A. Cisco Discovery Protocol is enabled on the switch.
B. The phone generates dhcp request packets.
C. The phone generates TFTP request packets.
D. Delete and re-create the phone.
Correct Answer: B
Explanation/Reference:

**Question 53**
Which performance and monitoring service must be restarted?
MGCP gateway is registered with Cisco Unified Communications Manager, but does not appear in the Cisco Unified Communications Manager Administration Page. Which performance and monitoring service must be restarted?
A. Cisco RIS data collector
B. Cisco DirSync
C. Cisco IP Manager Assistant
D. Cisco Bulk Provisioning Service
Correct Answer: A
Explanation/Reference:

**Question 54**
What are two methods of viewing lost packet statistics for a call between two Cisco Unified IP Phone 7945 phones that are registered to Cisco Unified Communications Manager? (Choose two.)
A. During the call, press the Settings key twice in succession on one of the IP phones.
B. During the call, press the Settings key, and then select Status > Call Statistics on one of the IP phones.
C. During the call, press the Web Services key twice in succession on one of the IP phones.
D. Find the completed call in Cisco Unified Serviceability > Tools > Dialed Number Analyzer.
E. Find the completed call in CDR Analysis and Reporting > CDR > Search > By User Extension.
F. Find the completed call in CDR Analysis and Reporting > System > Log Screens > Event Log.
Correct Answer: BE
Explanation/Reference:

**Question 55**
Which protocol is used by a Cisco PoE switch to deliver voice VLAN information to a Cisco IP phone?
Which protocol is used by a Cisco PoE switch to deliver voice VLAN information to a Cisco IP phone?
A. Cisco Discovery Protocol
B. User Datagram Protocol
C. Transmission Control Protocol
D. Session Initiation Protocol
Correct Answer: A
Explanation/Reference:

**Question 56**
Which service should be restarted as a troubleshooting step?
Adam is the network administrator of a company. He finds out that CDR files are being collected and pushed to the CDR Repository node but the files are not getting transferred to third-party billing servers. Which service should be restarted as a troubleshooting step?
A. CDR agent
B. CDR Repository Manager
C. CDRonDemand
D. Cisco CallManager
Correct Answer: B
Explanation/Reference:

**Question 57**
Which command is missing from the configuration for provisioning multiple connections with a single T1 interface?
Refer to the exhibit.
Which command is missing from the configuration for provisioning multiple connections with a single T1 interface?

Configuration controller t1 1/0
framing esf
linecode b8zs
clock source line
ds0-group 5 timeslots 1-5 type fxo-loopstart
A. ds0-group 5 timeslots 6-23 type fxo-loopstart
B. ds0-group 5 timeslots 6-24 type fxo-loopstart
C. ds0-group 6 timeslots 6-24 type fxo-loopstart
D. ds0-group 5 timeslots 1-24 type fxo-loopstart

Correct Answer: C
Explanation/Reference:

Question 58
Which is a voice signaling protocol that is used between telephone company Corporate Offices around the world?

A. SIP
B. H.323
C. SS7
D. MGCP 1.0

Correct Answer: C
Explanation/Reference:

Question 59
When you configure a T1 CAS PSTN Interface, which command instructs the router to receive its interface clocking from the service provider?

A. linecode b8zs
B. clock source line
C. ds0-group 1 timeslots 1-24
D. clock source internal

Correct Answer: B
Explanation/Reference:

Question 60
When you use the Dialed Number Analyzer in Cisco Unified Communications Manager, how does the output get saved?

A. as an analysis that only appears on the screen, so you must copy it to another program to save it
B. as a zipped file accessible through the GUI interface
C. as a text file named dnaOutput callingparty dialeddigits .xml on the Cisco Unified CM server
D. as an XML file named dnaOutput callingparty dialeddigits .xml on your local PC

Correct Answer: D
Explanation/Reference:

Question 61
What is the command you should use for clocking synchronization?

A. clock source line
B. clock source internal
C. clock source free-running
D. clock source external

Correct Answer: A
Explanation/Reference:
Question 62
What is the interface type that you should use to connect a PSTN analog line to the VoIP network?
A. FXS
B. FXO
C. E and M
D. serial
Correct Answer: B

Question 63
The Cisco Unity DiRT program is recommended for which task?
A. daily system backups
B. live backups while the system is in production use
C. making a full image of the Cisco Unity server
D. upgrading Cisco Unity to a new version or migrating to a new server
Correct Answer: D

Question 64
Which two features must be specified when you perform a manual backup of Cisco Unified Communications Manager to a network directory/destination? (Choose two.)
A. file extension
B. schedule date and time
C. server name
D. TFTP server IP address
E. transport method (ftp, tftp)
F. user name
Correct Answer: CF

Question 65
What are two methods of invoking a manual system backup of Cisco Unified Communications Manager? (Choose two.)
A. Using the CLI, via the command, utils disaster_recovery backup.
B. In Cisco Disaster Recovery System, navigate to Backup > Manual Backup.
C. In Cisco Disaster Recovery System, navigate to Backup > Backup Device.
D. In Cisco Disaster Recovery System, navigate to Backup > Scheduler.
E. In Cisco Unified CM Administration, navigate to Bulk Administration > Upload/Download Files.
F. In Cisco Unified CM Administration, navigate to Bulk Administration > Import/Export > Export.
Correct Answer: AB

Question 66
What should an administrator have access to during a system backup?
A. CLI
B. GUI interface
C. DN interface
D. user accounts
Correct Answer: A

Question 67
Which server does Cisco recommend that you configure before a CUCM backup?
A. SFTP
B. FTP
C. SNMP
D. TFTP
Correct Answer: A
Question 68
Which option will only display for unassigned directory numbers?
Which option will only display for unassigned directory numbers?
A. Active check box  
B. Allow Control of Device from CTI  
C. Retain this destination in the call forwarding history  
D. Use Device Pool Calling Party Transformation CSS  

Correct Answer: A  
Explanation/Reference:  

Question 69
Which two choices are used to remove unassigned DN in Cisco Unified Communications Manager?  
Which two choices are used to remove unassigned DN in Cisco Unified Communications Manager? (Choose two.)  
A. Route Plan Report 
B. dial rules 
C. Bulk Administration 
D. Dialed Number Analyzer  

Correct Answer: AC  
Explanation/Reference:  

Question 70
What is the root cause of this issue?
A network administrator uses autoregistration to register IP phones to Cisco Unified Communications Manager. Later, the administrator changes the DN of the autoregistered phone to free the DN in the autoregistration range. After a certain amount of time, the phones fail to autoregister, displaying “Error DB Config” or a similar message on the IP Phone screen. What is the root cause of this issue?
A. The network is down. 
B. Cisco Unified Communications Manager server is down. 
C. The phone is faulty. 
D. The DNs are marked as unassigned.  

Correct Answer: D  
Explanation/Reference:  

Question 71
Which two procedures should be used to search for unassigned directory numbers? 
Which two procedures should be used to search for unassigned directory numbers? (Choose two.) 
A. Route Partition 
B. Directory Number 
C. Phone Number 
D. Phone Serial Number  

Correct Answer: AB  
Explanation/Reference:  

Question 72
When Cisco Unity voice mailbox subscribers (using Cisco Unity on Microsoft Exchange) have exceeded the “prohibit send and receive” setting of their mailbox size, where does a message from an unidentified caller go? 
By default, when Cisco Unity voice mailbox subscribers (using Cisco Unity on Microsoft Exchange) have exceeded the “prohibit send and receive” setting of their mailbox size, where does a message from an unidentified caller go? 
A. nowhere (It is deleted.) 
B. the subscriber’s mailbox, but it is unavailable until some messages are deleted 
C. the subscriber’s mailbox, with warning 
D. the system administrator mailbox 
E. the Unaddressed Messages distribution list  

Correct Answer: E  
Explanation/Reference:  

Question 73
How many Cisco Unified Wireless IP Phone 7925 handsets will this quantity of licenses support? 
After obtaining a License Unit Report from Cisco Unified Communications Manager, it shows you have 19 license units remaining. How many Cisco Unified Wireless IP Phone 7925 handsets will this quantity of licenses support? 
A. 3 
B. 4 
C. 5 
D. 19  

Correct Answer: B  
Explanation/Reference:  

Question 74
Question 75
What are the two Cisco Unity Connection built-in reporting interfaces?
What are the two Cisco Unity Connection built-in reporting interfaces? (Choose two.)
A. Cisco Unified Reporting
B. Cisco Unity Connection Reporting
C. Cisco Unity Connection Serviceability Reports Tool
D. Cisco Unified Serviceability Reports Archive

Correct Answer: CD
Explanation/Reference:

Question 76
When a phone that is registered as a Skinny Client Control Protocol device goes off hook, which counter gets incremented until it goes back on hook?
When a phone that is registered as a Skinny Client Control Protocol device goes off hook, which counter gets incremented until it goes back on hook?
A. CallsAttempted
B. CallsActive
C. CallsInProgress
D. CallsCompleted

Correct Answer: C
Explanation/Reference:

Question 77
What is the default alert level of a performance counter object in Cisco Unified Real-Time Monitoring Tool?
What is the default alert level of a performance counter object in Cisco Unified Real-Time Monitoring Tool?
A. warning
B. notice
C. debug
D. informational

Correct Answer: A
Explanation/Reference:

Question 78
Which two RTMT reports display information about completed calls?
Which two RTMT reports display information about completed calls? (Choose two.)
A. Alert Summary
B. Call Activities
C. Performance Protection
D. Device Statistics
E. Server Statistics
F. Service Statistics

Correct Answer: BC
Explanation/Reference:

Question 79
Which two services must be running to enable report publishing for RTMT?
Which two services must be running to enable report publishing for RTMT? (Choose two.)
A. Cisco RIS data collector
B. Cisco RTMT Reporter servlet
C. Cisco Serviceability Reporter
D. Cisco Trace Collection servlet
E. Cisco Trace Collection Service
F. Cisco Extended Functions

Correct Answer: BC
Explanation/Reference:

Question 80
Which two protocols does Real-Time Monitoring Tool use to monitor system performance and device status?
Which two protocols does Real-Time Monitoring Tool use to monitor system performance and device status? (Choose two.)
A. HTTPS
B. TCP
Question 81
Which four tasks does RTMT allow an administrator to perform?
Which four tasks does RTMT allow an administrator to perform? (Choose four.)
A. View syslog messages.
B. Generate alerts when threshold is below or above user-configured.
C. Monitor a set of predefined management objects that monitor the health of the system.
D. Collect information and traces about errors or alerts that exist in the RTMT.
E. Reboot the system.
F. Perform incremental backups.
G. Export CDR.
Correct Answer: ABCD
Explanation/Reference:

Question 82
Which service is responsible for generating reports in Cisco Unity Connection?
Which service is responsible for generating reports in Cisco Unity Connection?
A. Connection Reports Data Harvester
B. Cisco DirSync
C. Connection Server Role Manager
D. Connection Mailbox Sync
Correct Answer: A
Explanation/Reference:

Question 83
Which URL is the correct URL with which to access the Cisco Unified Reporting tool in Cisco Unified Communications Manager?
Which URL is the correct URL with which to access the Cisco Unified Reporting tool in Cisco Unified Communications Manager?
A. https://ip_address/cucreports
B. https://ip_address/cucreports
C. https://ip_address/cucadmin
D. https://ip_address/ccmreports
E. https://ip_address/ccmreports
Correct Answer: A
Explanation/Reference:

Question 84
Which service will the reporting system use in Cisco Unified Communications Manager?
Which service will the reporting system use in Cisco Unified Communications Manager?
A. Cisco Tomcat service
B. Cisco CDR service
C. Cisco CAR service
D. Cisco CLI Functionality service
Correct Answer: A
Explanation/Reference:

Question 85
Which Cisco Unified Communications Manager report is being displayed?
Refer to the exhibit.
Which Cisco Unified Communications Manager report is being displayed?
A. Unified CM User Device Count
B. Unified CM Extension Mobility
C. Unified CM Device Distribution Summary
D. License Unit Report
Correct Answer: A
Explanation/Reference:

Question 86
What are two methods of displaying the device count of a particular IP phone type in Cisco Unified Communications Manager versions before 9.x?
What are two methods of displaying the device count of a particular IP phone type in Cisco Unified Communications Manager versions before 9.x? (Choose two.)
A. In Cisco Unified CM Administration, navigate to System > Licensing > License Unit Report.
B. In Cisco Unified CM Administration, navigate to System > Licensing > License Unit Calculator.
C. In Cisco Unified CM Administration, navigate to System > Licensing > Capabilities Assignment.
D. In Cisco Unified CM Administration, navigate to Device > Device Settings > Firmware Load Information.
E. In Cisco Unified Reporting, select System Reports > Unified CM Device Counts Summary.
F. In Cisco Unified Reporting, select System Reports > Unified CM Extension Mobility.
G. In Cisco Unified Reporting, select System Reports > Unified CM User Device Count.

Correct Answer: BE
Explanation/Reference:

Question 87
Which protocol allows Cisco Unity Connection to retrieve and manage secure voice messages for the end user?
Which protocol allows Cisco Unity Connection to retrieve and manage secure voice messages for the end user?
A. LDAPS
B. SSL
C. XMPP
D. TLS

Correct Answer: D
Explanation/Reference:

Question 88
Which service must be activated to locate the CDR Analysis and Reporting tool under the Tools section in Cisco Unified Serviceability?
Which service must be activated to locate the CDR Analysis and Reporting tool under the Tools section in Cisco Unified Serviceability?
A. Cisco CAR Web Service
B. Cisco Messaging Interface
C. Cisco WebDialer Web Service
D. Cisco UXL Web Service

Correct Answer: A
Explanation/Reference:

Question 89
What type of CDR and CMR files can be downloaded from the call manager server?
What type of CDR and CMR files can be downloaded from the call manager server?
A. XLS
B. PDF
C. PPT
D. CSV

Correct Answer: D
Explanation/Reference:

Question 90
What is the service parameter that determines whether or not CDRs will be generated?
What is the service parameter that determines whether or not CDRs will be generated?
A. CDR Enabled Flag
B. Call Diagnostics Enabled
C. Display FAC in CDR
D. SDL Trace Flag Enabled

Correct Answer: A
Explanation/Reference:

Question 91
How fast can Cisco Unified Communications Manager generate CDR and CMR files?
How fast can Cisco Unified Communications Manager generate CDR and CMR files?
A. One CDR file and one CMR file every second for up to 1 minute
B. One CDR file and one CMR file every minute for up to 1 hour
C. Ten CDR files and ten CMR files every hour for up to 1 day
D. Ten CDR files and ten CMR files every day for up to 1 week

Correct Answer: C
Explanation/Reference:

Question 92
Which type of Cisco Unified Communications Manager user sends authentication in line with a request to read or write information to a CDR or CAR database?
Which type of Cisco Unified Communications Manager user sends authentication in line with a request to read or write information to a CDR or CAR database?
A. end user  
B. LDAP user  
C. application end user  
D. authentication user  

Correct Answer: C  
Explanation/Reference:

**Question 93**  
What is the reason that Cisco Unity Connection fails to find the Cisco Unified Communications Manager user with extension 6654?  
Refer to the exhibit.

What is the reason that Cisco Unity Connection fails to find the Cisco Unified Communications Manager user with extension 6654?  
A. The user has already been imported into the Cisco Unity Connection database.  
B. The user has a Primary Extension correctly configured.  
C. The user has not been synchronized with Cisco Unity Connection.  
D. The user is not a member of the Standard CTI Enabled user group.  

Correct Answer: A  
Explanation/Reference:

**Question 94**  
Which statement about the Cisco Unified Presence user, “IT Support,” is true?  
Refer to the exhibit.

Which statement about the Cisco Unified Presence user, “IT Support,” is true?  
A. The user is logged into Cisco Unified Personal Communicator.  
B. The user is correctly associated with the appropriate Directory Number Line Appearance.  
C. The user has enabled the Do Not Disturb feature on the desk IP phone.  
D. The user has enabled the Do Not Disturb feature on Cisco Unified Personal Communicator.  

Correct Answer: B  
Explanation/Reference:

**Question 95**  
Which describes how to provide a third directory number button and a BLF speed dial for twelve of the Cisco Unified IP Phone 7965?  
Which describes how to provide a third directory number button and a BLF speed dial for twelve of the Cisco Unified IP Phone 7965?  
A. Modify the Standard User softkey template.  
B. Copy the Standard User softkey template, name it, and add the requested features.  
C. Copy the Standard 7965 SCCP phone button template, rename it, and add the requested features.  
D. It is not possible to add a third DN and a BLF speed dial to the IP Phone 7965 IP.  

Correct Answer: C  
Explanation/Reference:

**Question 96**  
Changes that are made to the directory numbers in Cisco Unified Communications Manager 8.x are stored in which database?  
Changes that are made to the directory numbers in Cisco Unified Communications Manager 8.x are stored in which database?  
A. IBM Informix  
B. CAR database  
C. SQL database  
D. TimesTen  

Correct Answer: A  
Explanation/Reference:
Question 97
What is a method of modifying the External Phone Number Mask on multiple line appearances of a directory number simultaneously? Refer to the exhibit.

What is a method of modifying the External Phone Number Mask on multiple line appearances of a directory number simultaneously?
A. Bulk Administration > Phones > Add/Update Lines > Update Lines
B. Bulk Administration > Users > Line Appearance > Update Line Appearance
C. Call Routing > Directory Number > Directory Number Configuration > Edit Line Group
D. Bulk Administration > Phones > Update Phones > Query

Correct Answer: A
Explanation/Reference:

Question 98
Which configuration item is at fault?
When a user calls a Cisco Unified Communications Manager telephone and another call is already in progress on that telephone, the calling user sees incorrect line identification information. Which configuration item is at fault?
A. The calling user dialed the wrong number.
B. The directory number exists in two partitions, but each line has different line identification information.
C. The call was forwarded to another directory number.
D. The line that was called cannot accept more than one call at a time.

Correct Answer: B
Explanation/Reference:

Question 99
Which two methods are used to initiate the creation of a directory number while performing GUI Administration of Cisco Unified Communications Manager?
Which two methods are used to initiate the creation of a directory number while performing GUI Administration of Cisco Unified Communications Manager? (Choose two.)
A. Follow Call Routing > Directory Number menu and choose Add New.
B. Follow Device > Settings Directory Number menu and choose Add New.
C. Under User Management, choose Device Association > Create New.
D. When you create the phone, choose either line option from the Association Information menu.

Correct Answer: AD
Explanation/Reference:

Question 100
When phones are divided in a group where all phones can answer a call, what is that setup called?
When phones are divided in a group where all phones can answer a call, what is that setup called?
A. call accounting
B. call pickup
C. call grouping
D. intercom

Correct Answer: B
Explanation/Reference:

Question 101
Which method can be used to retrieve a call that is placed on hold from a Cisco IP phone?
Which method can be used to retrieve a call that is placed on hold from a Cisco IP phone?
A. call hold
B. call park
C. call slot
D. transfer call

Correct Answer: B
Explanation/Reference:
Question 102
How does the following configuration affect calling privileges?

ICOMM_ROUTER(config)#dial-peer cor list 911-LOCAL
ICOMM_ROUTER(config-dp-corlist)#member 911
ICOMM_ROUTER(config-dp-corlist)#member LOCAL
ICOMM_ROUTER(config-dp-corlist)#exit

A. Anyone assigned to this COR list can make 911 calls only.  
B. Anyone assigned to this COR list can make local calls only.  
C. Anyone assigned to this COR list can make either 911 or local calls.  
D. Anyone assigned to this COR list can make long distance calls only.

Correct Answer: C
Explanation/Reference:

Question 103
What is the cause of the error message?
Refer to the exhibit.

A. The command auto-reg-ephone was not added under telephony-service CLI.  
B. There are no free licenses to add more phones.  
C. There is no free flash space to upload firmware for the phones.  
D. It is just an error message, and you only have to press OK.

Correct Answer: A
Explanation/Reference:

Question 104
When you attempt to add a phone to the Cisco Unified Communications Manager Express using the GUI interface, the error “No New Phone to Add” appears. Which command is causing the error?

A. no auto-reg-ephone  
B. no service ephone-reg  
C. sip-ua no auto-reg-ephone  
D. stcapp ccm-group 1

Correct Answer: A
Explanation/Reference:

Question 105
Which command is used to verify that the Cisco IOS files that are needed to perform GUI administration are present?

A. show running-config  
B. show version  
C. show flash  
D. show inventory

Correct Answer: C
Explanation/Reference:

Question 106
Which three options are used for adding phones to Cisco Unified Communications Manager using autoregistration? (Choose three.)

A. phone template  
B. device pool  
C. starting directory number  
D. phone button template  
E. calling search space  
F. partition  
G. external phone number mask  
H. common phone profile

Correct Answer: CFG
Question 107
What is the name of the software that allows for LDAP synchronization of user information into Cisco Unified Communications Manager?
A. Active Directory
B. DirSync
C. DomainImport
D. Session Initiation Protocol
Correct Answer: B

Question 108
How would you add or delete users after you have configured your Cisco Unified Communications Manager to use your LDAP corporate directory for end users considering that you are not using Cisco Unified Communications Manager 9.x or later?
A. Add or delete the user in UCM User Management tab.
B. Add or delete the user in your LDAP corporate directory.
C. Check the Delete User check box in UCM user list, or click the Add New User button in UCM user list.
D. Use either option A or B; both accomplish the same thing.
Correct Answer: B

Question 109
Which three tools are used to create phone user accounts in Cisco Unified Communications Manager Express?
A. Cisco Configuration Professional
B. CPE
C. CLI
D. GUI
E. TUI
F. Cisco Security Device Manager
Correct Answer: ACD

Question 110
What are the three methods that are used to create end users in Cisco Unified Communications Manager?
A. manual entry
B. manual copy of user object
C. bulk import
D. LDAP authentication
E. LDAP import
F. synchronization via LDAP
Correct Answer: ACF

Question 111
Which three choices are required for the boot process for a Cisco IP phone?
A. TFTP services
B. DHCP services
C. voice VLAN
D. routing protocol
E. TCP/IP
F. PortFast
Correct Answer: ABC

Question 112
Which two signaling messages would you see on a network containing both Cisco Skinny and third-party IP phones that are registered to a Cisco UnifiedCommunications Manager?
A. off hook
B. station invite
C. invite
D. invitation
Correct Answer: AC
Explanation/Reference:

**Question 113**
Which two choices are Cisco gateway control protocols?
Which two choices are Cisco gateway control protocols? (Choose two.)
A. H.323
B. TCP/IP
C. IETF
D. SIP
E. RTFMP
F. UDP

Correct Answer: AD
Explanation/Reference:

**Question 114**
Which port is the default port for SCCP call signaling on Cisco Unified Communications Manager?
Which port is the default port for SCCP call signaling on Cisco Unified Communications Manager?
A. 2000
B. 2443
C. 5060
D. 5061

Correct Answer: A
Explanation/Reference:

**Question 115**
What is the combined total number of signaling conversations and media flows that used the SCCP phone as an endpoint?
An SCCP IP phone places a call to a SIP phone that is registered to the same Cisco Unified Communications Manager Express. During the active call, call waiting indicates a second call is incoming to the handset, but the user decides to ignore it. In this scenario, what is the combined total number of signaling conversations and media flows that used the SCCP phone as an endpoint?
A. 2
B. 3
C. 4
D. 5
E. 6

Correct Answer: B
Explanation/Reference:

**Question 116**
Which Cisco voice messaging components support active-passive redundancy?
Which Cisco voice messaging components support active-passive redundancy?
A. Cisco Unity Express
B. Cisco Unified Communications Manager Business Edition
C. Cisco Unity
D. Cisco Unity Connection

Correct Answer: C
Explanation/Reference:

**Question 117**
What is the most important factor that contributes to network design availability and reliability?
What is the most important factor that contributes to network design availability and reliability?
A. high availability
B. data backup
C. vendor-specific
D. fault management

Correct Answer: A
Explanation/Reference:

**Question 118**
Which three choices are functions or features of Cisco Unity Connection?
Which three choices are functions or features of Cisco Unity Connection? (Choose three.)
A. video-enabled messaging through converged networks
B. text-to-speech, which allows access to Exchange emails from a telephone
C. voice-enabled message navigation
D. voice-enabled dialing to external users
E. automated attendant capabilities
F. automated call rerouting to agents through round robin, longest idle, or broadcast
Correct Answer: BCE
Explanation/Reference:

**Question 119**
Which two layers are Cisco Unified Communications component layers?
Which two layers are Cisco Unified Communications component layers? (Choose two.)
A. infrastructure layer  
B. data link layer 
C. network layer 
D. endpoints layer 
E. transport layer 

Correct Answer: AD
Explanation/Reference:

**Question 120**
Cisco Jabber facilitates online communication through the use of all of these features except one. Which one?
Cisco Jabber facilitates online communication through the use of all of these features except one. Which one?
A. chat  
B. desktop sharing 
C. Microsoft SharePoint workspace integration 
D. Microsoft Outlook integration 
E. Presence 
F. video conferencing 

Correct Answer: C
Explanation/Reference:

**Question 121**
Which server collects information about the availability and communication capability of a user?
Which server collects information about the availability and communication capability of a user?
A. Cisco Unified Communications Manager 
B. Cisco Unified Presence 
C. Cisco Unified MeetingPlace 
D. database application 

Correct Answer: B
Explanation/Reference:

**Question 122**
What is the function for the Restart button of a configured IP phone in the Phone Configuration window under Cisco Unified Communications Manager web administration page?
What is the function for the Restart button of a configured IP phone in the Phone Configuration window under Cisco Unified Communications Manager web administration page?
A. It means a restart for the firmware and the configuration. 
B. It means unregistering and then registering the phone again with the Cisco Unified CM. 
C. It means to unregister the phone from the Cisco Unified CM. 
D. There is no Restart button in the Cisco Unified CM. 

Correct Answer: B
Explanation/Reference:

**Question 123**
Which sequence of touch pad keys is used to reset a Cisco IP phone?
Which sequence of touch pad keys is used to reset a Cisco IP phone?
A. #*#*#  
B. **#**  
C. ##*##  
D. *#*#* 

Correct Answer: B
Explanation/Reference:

**Question 124**
Which choice reduces the call quality?
Which choice reduces the call quality?
A. high bitrate  
B. low bitrate 
C. number of endpoints (phones) 
D. CPU usage 

Correct Answer: B
Explanation/Reference:
Question 125
What must be configured to resolve the issue?
A Cisco Unity Connection administrator has set up a shared mailbox for a group of users and configures their extensions to forward to voicemail if the call is unanswered. Users report that callers are not reaching the mailbox and hear only the default system message. What must be configured to resolve the issue?
A. direct routing rule
B. forwarded routing rule
C. system distribution list
D. search space
Correct Answer: B
Explanation/Reference:

Question 126
Which section can be configured to allow for a longer voicemail?
Refer to the exhibit.

![Message Settings](http://www.aoowe.com/practice-640-461-3180.html)

Users are complaining that Cisco Unity Connection is cutting their voice mails too short. Which section can be configured to allow for a longer voicemail?
A. Message Urgency
B. Message Settings
C. After Message Action
D. Message Security
Correct Answer: B
Explanation/Reference:

Question 127
Which two options are causing the problem?
A new user is unable to log into voice mail and no one is able to leave this user a voice-mail message. Which two options are causing the problem? (Choose two.)
A. The extension number was not configured in Cisco Unity Connection.
B. The TUI settings are set to default.
C. The mailbox size is too small.
D. The DN was misconfigured in Cisco Unified Communications Manager.
Correct Answer: AD
Explanation/Reference:

Question 128
Which IP address will the IP phones be provided as the TFTP server?
Refer to the exhibit.

```
import ipaddress
network 209.165.290.224 255.255.255.224
option 150 209.165.290.225
default-router 209.165.290.226
domain-name cisco.com
dns-server 209.165.290.226 209.165.290.227 209.165.290.228
```

Which IP address will the IP phones be provided as the TFTP server?
A. 209.165.200.225
B. 209.165.200.226
C. 209.165.201.1
D. 209.165.202.129

Correct Answer: A
Explanation/Reference:

**Question 129**
When trying to register to Cisco Unified Communications Manager via autoregistration. Which two options are ways to fix the problem?

The display on a phone shows the message “Error DB Config” when trying to register to Cisco Unified Communications Manager via autoregistration. Which two options are ways to fix the problem? (Choose two.)

A. Add to the range of autoregistration DNs.
B. Restore only valid directory numbers using the CAR tool.
C. Delete the device, and its directory number will be deleted automatically.
D. Navigate to System > Route Plan Report > Unassigned DNs > Delete Selected

Correct Answer: AD
Explanation/Reference:

**Question 130**
What two things is a watcher monitoring in real time?
In Cisco Unified Communications Manager Native Presence, what two things is a watcher monitoring in real time? (Choose two.)

A. registration status of a specific IP phone
B. registration status of the hunt group
C. registration status of the MGCP gateway
D. registration status of Cisco Extension Mobility of the IP phone
E. status of a registered directory number

Correct Answer: AE
Explanation/Reference:

**Question 131**
When someone is troubleshooting a network issue, what should be the first step according to troubleshooting methodology?

When someone is troubleshooting a network issue, what should be the first step according to troubleshooting methodology?

A. Define the problem.
B. Gather the facts.
C. Document the facts.
D. Consider the possibilities.

Correct Answer: A
Explanation/Reference:

**Question 132**
What should be installed on a Cisco IP phone if a user wants information to display in any language other than English?

What should be installed on a Cisco IP phone if a user wants information to display in any language other than English?

A. locale installer
B. media resources
C. language bundle
D. run update

Correct Answer: A
Explanation/Reference:

**Question 133**
Which port is configured for connection to the PSTN?

Which port is configured for connection to the PSTN?

A. T1
B. FAS
C. FXS
D. FXO

Correct Answer: D
Explanation/Reference:

**Question 134**
What is the cause of this problem?

You receive a call from a remote location that the fax machine cannot dial out, but all the IP phones are working. What is the cause of this problem?

A. The POTS line is down.
B. Cisco Unified Communications Manager is down.
C. The PoE switch has lost power.
D. The VLAN assignment is incorrect.

Correct Answer: A
Question 135
Which account has access to the DRS by default?
You are assigned the task of performing a manual backup of CDR data. Which account has access to the DRS by default?
A. Platform Administrative account
B. Application end users account
C. Master Agent account
D. Cisco License Manager account
Correct Answer: A
Explanation/Reference:

Question 136
What procedure should an administrator apply to delete a directory number from CUCM database?
What procedure should an administrator apply to delete a directory number from CUCM database?
A. Call Routing > Route Plan Report
B. Call Routing > Delete DN
C. Phone Directory > Delete DN
D. Delete > Phone Directory
Correct Answer: A
Explanation/Reference:

Question 137
Which Cisco Unified Communications Manager monitoring view in RTMT can display graphs for registered phones and calls in progress?
Which Cisco Unified Communications Manager monitoring view in RTMT can display graphs for registered phones and calls in progress?
A. Database Summary
B. Gateway Activity
C. CallManager Summary
D. Device Search
Correct Answer: C
Explanation/Reference:

Question 138
What defines a report user as a Manager as opposed to just a User in the CAR reporting tool?
What defines a report user as a Manager as opposed to just a User in the CAR reporting tool?
A. The account of the report user is referenced in the Manager User ID field of another user’s account.
B. The account of the report user is a member of the Standard CAR Manager Users Group.
C. The Manager check box is checked in the CAR User Configuration page.
D. Managers log in to a different CAR Reports tool than users do.
Correct Answer: A
Explanation/Reference:

Question 139
When what disk space capacity is reached by default?
The Cisco Unity Connection Report Harvester is stopped when what disk space capacity is reached by default?
A. 75 percent
B. 80 percent
C. 85 percent
D. 90 percent
Correct Answer: B
Explanation/Reference:

Question 140
Which menu path takes you to the CAR report that should be run to determine the length of long distance calls made from a company?
Which menu path takes you to the CAR report that should be run to determine the length of long distance calls made from a company?
A. Bills > Individual
B. Bills > Department
C. Top N > By Duration
D. Top N > Number of Calls
Correct Answer: C
Explanation/Reference:

Question 141
How is the calendar information in Microsoft Exchange integrated into CUPS Presence signaling so that the Free/Busy status in an Outlook calendar can be mapped to the Available/Away Presence status?
How is the calendar information in Microsoft Exchange integrated into CUPS Presence signaling so that the Free/Busy status in an Outlook calendar can be mapped to the Available/Away Presence status?
A. using WebDAV
B. using SIP/SIMPLE
C. using CTIQBE
D. using XMPP

Correct Answer: A
Explanation/Reference:

**Question 142**
Which method is used by Cisco Unified Communications Manager to provide IP phone line status information to Cisco Unified Presence?

A. Cisco Unified Communications Manager IP Phone Service Device Info
B. SIP Publish
C. LDAP synchronization
D. XML-via-HTTP signaling
E. SCCP Station Call information

Correct Answer: B
Explanation/Reference:

**Question 143**
What are three client applications that interface directly with Cisco Unified Presence? (Choose three.)

A. Cisco Unified Personal Communicator
B. Cisco Jabber Video for TelePresence
C. Cisco IP Communicator
D. Cisco Jabber
E. Cisco Unified Mobile Connector
F. Microsoft Lync
G. Microsoft Messenger
H. Microsoft Office Communicator

Correct Answer: ADE
Explanation/Reference:

**Question 144**
Which is a method of modifying the System Default Greeting for a CUCM integrated user in Cisco Unity Connection?

A. Use CUC Administration to navigate to Users > Edit User Basics, and then modify the Alias field.
B. Use CUC Administration to navigate to Users > Edit User Basics, and then modify the First Name and Last Name fields.
C. Use CUC Administration to navigate to Users > Edit User Basics, and then modify the Display Name field.
D. Use CUCM Administration to navigate to User Management > Find Users, and then modify the User ID.
E. Use CUCM Administration to navigate to User Management > Find Users, and then modify the Mail ID.

Correct Answer: C
Explanation/Reference:

**Question 145**
Which three methods can be used to import multiple Cisco Unity Connection users at one time on a system that is integrated with Cisco Unified Communications Manager? (Choose three.)

A. AXL server
B. LDAP connection
C. user creation tool
D. user import function
E. XLS import
F. You cannot import multiple users at one time.

Correct Answer: ABD
Explanation/Reference:

**Question 146**
What does Cisco recommend as the maximum number of ports and users for Cisco Unity Connection on a single server?

A. 100 ports, 10,000 users
B. 250 ports, 20,000 users
C. 250 ports, 50,000 users
D. 500 ports, 20,000 users

Correct Answer: B
Explanation/Reference:
Which two steps in configuration must be completed to deploy Cisco Unified Personal Communicator? (Choose two.)

A. Each user must have a unique ID.
B. The user ID is converted into a softphone device name.
C. The users must power their PCs.
D. Each user must provide a username and password.

Correct Answer: AB

Explanation/Reference:

Question 148
What are three methods used by the administrator to integrate the LDAP directory in a corporate organization? (Choose three.)

A. User provisioning
B. User authentication
C. User lookup
D. User login
E. User password
F. User default settings

Correct Answer: ABC

Explanation/Reference:

Question 149
Which section of the user template is CoS configured in Cisco Unity Connection?

A. Location
B. Name
C. Phone
D. System

Correct Answer: C

Explanation/Reference:

Question 150
How many passwords are utilized for each user in Cisco Unity Connection?

A. 0
B. 1
C. 2
D. 3

Correct Answer: C

Explanation/Reference:

Question 151
What would happen to the user in Cisco Unity Connection?

Refer to the exhibit.

A user was imported to Cisco Unity Connection through LDAP integration. The user was later deleted from Active directory. What would happen to the user in Cisco Unity Connection?

A. User would get purged immediately.
B. User would be converted to a permanent Cisco Unity Connection legacy user in 24 hours.
C. User would get purged in 24 hours.
D. User would be converted to a permanent Cisco Unity Connection legacy user immediately.

Correct Answer: B

Explanation/Reference:

Question 152
Which statement describes the reason that some of the user accounts that are imported from Cisco Unified Communications Manager into Cisco Unity Connection using AXL do not appear in the list of users that is found via AXL?
Which statement describes the reason that some of the user accounts that are imported from Cisco Unified Communications Manager into Cisco UnityConnection using AXL do not appear in the list of users that is found via AXL?
A. The LDAP manager account password is incorrect.
B. The DirSync service is not activated.
C. The missing user accounts are not configured with a primary extension in the Cisco Unified Communications database.
D. The missing user accounts had the Do Not List In Directory setting checked.

Correct Answer: C
Explanation/Reference:

**Question 153**
Which Cisco Unity Connection import method is being configured?
Refer to the exhibit.

<table>
<thead>
<tr>
<th>User ID</th>
<th>SAMAccountName</th>
<th>First Name</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Middle Name</td>
<td></td>
<td>Last Name</td>
</tr>
<tr>
<td>Manager ID</td>
<td>manager</td>
<td>Department</td>
</tr>
<tr>
<td>Phone Number</td>
<td>telephoneNumber</td>
<td>Mail ID</td>
</tr>
</tbody>
</table>

Which Cisco Unity Connection import method is being configured?
A. CDR
B. BAT
C. LDAP
D. COBRAS

Correct Answer: C
Explanation/Reference:

**Question 154**
When creating users manually in Cisco Unity Connection, where is the user data maintained?

A. IBM Informix database
B. Local Cisco Unity Connection database
C. LDAP
D. Cisco Unified Communications Manager

Correct Answer: B
Explanation/Reference:

**Question 155**
Which tool can be used to migrate and import users into Cisco Unity Connection?

A. .xls
B. COBRAS
C. TFTP
D. SFTP

Correct Answer: B
Explanation/Reference:

**Question 156**
Which type of data file is used for bulk import of users into Cisco Unity Connection?

A. .xls
B. .doc
C. .csv
D. .pdf

Correct Answer: C
Explanation/Reference:

**Question 157**
What type of SIP trunk does a Cisco Call Back support?

A. QSIG enable
B. QUERTY enable
C. 802.1q
D. ISL

Correct Answer: A
Explanation/Reference:

**Question 158**
Which standard will support call forwarding?
A. H.450.3
B. H.323
C. RFC 2833
D. H.450.2
Correct Answer: A
Explanation/Reference:

Question 159
How does Cisco Unified Personal Communicator control the desk phone of users?
A. IP address
B. CTI
C. SSH
D. SCCP
Correct Answer: B
Explanation/Reference:

Question 160
What is the maximum number of lines that is supported by Cisco Unified IP Phone 7965?
A. 2 lines
B. 4 lines
C. 6 lines
D. 8 lines
Correct Answer: C
Explanation/Reference:

Question 161
Which three items are required to provision core telephony service on the Cisco Unified Communications Manager Express router? (Choose three.)
A. MAC address
B. IP source address
C. dial peer
D. ephone
E. max-dn
F. max-ephone
Correct Answer: BEF
Explanation/Reference:

Question 162
Which two statements about COR lists are true? (Choose two.)
A. If there is no outgoing COR list applied, the call is routed.
B. If there is no outgoing COR list applied, the call is blocked.
C. If there is no incoming COR list applied, the call is routed.
D. If there is no incoming COR list applied, the call is blocked.
Correct Answer: AC
Explanation/Reference:

Question 163
Which path would you use to display the configuration of a phone in Cisco Configuration Professional?
A. Configure > Unified Communications > Users, Phones and Extensions > Extensions
B. Configure > Unified Communications > Users, Phones and Extensions > User Settings
C. Configure > Unified Communications > Telephony Settings > User Settings
D. Configure > Unified Communications > Telephony Settings > Phones
E. Configure > Unified Communications > Users, Phones and Extensions > Phones and Users
Correct Answer: E
Explanation/Reference:

Question 164
Which protocol is used by a Cisco IP phone to learn the voice VLAN ID from the Cisco switch to which it is connected?
A. Dynamic Host Configuration Protocol
B. Trivial File Transfer Protocol
C. Network Time Protocol

D. Cisco Discovery Protocol

Correct Answer: D
Explanation/Reference:

**Question 165**
Which four fields are required when manually configuring IP phones in Cisco Unified Communications Manager?

Which four fields are required when manually configuring IP phones in Cisco Unified Communications Manager? (Choose four.)
A. MAC Address
B. IP Address
C. Hunt Group
D. VLAN ID
E. Device Pool
F. Phone Button Template
G. Dial Peer
H. Device Security Profile

Correct Answer: AEFH
Explanation/Reference:

**Question 166**
Which path would you use to implement end users in Cisco Unified Communications Manager Express using Cisco Configuration Professional?

Which path would you use to implement end users in Cisco Unified Communications Manager Express using Cisco Configuration Professional?
A. Configure > Unified Communications > Telephony Settings > User Settings
B. Configure > Unified Communications > Users, Phones and Extensions > Phones
C. Configure > Unified Communications > Users, Phones and Extensions > User Settings
D. Configure > Unified Communications > Users, Phones and Extensions > Extensions
E. Configure > Unified Communications > Users, Phones and Extensions > Phones and Users

Correct Answer: E
Explanation/Reference:

**Question 167**
Which two fields are required to successfully create a phone user in Cisco Unified Communications Manager?

Of the fields listed, which two fields are required to successfully create a phone user in Cisco Unified Communications Manager? (Choose two.)
A. Last Name
B. PIN (and confirmation PIN)
C. Primary Extension
D. User ID

Correct Answer: AD
Explanation/Reference:

**Question 168**
Which file extension is used with the Bulk Administration Tool to automatically populate and insert data into the database when adding users in bulk?

Which file extension is used with the Bulk Administration Tool to automatically populate and insert data into the database when adding users in bulk?
A. CSV
B. RAR
C. NTP
D. TAR

Correct Answer: A
Explanation/Reference:

**Question 169**
Which three models of configuration does Cisco Unified Communications Manager Express support?

Which three models of configuration does Cisco Unified Communications Manager Express support? (Choose three.)
A. keyswitch
B. PBX
C. hybrid
D. PSTN
E. WAN
F. voice gateway
G. MOH

Correct Answer: ABC
Explanation/Reference:

**Question 170**
Which three options are the correct methods to implement end users in Cisco Unified Communications Manager?

Which three options are the correct methods to implement end users in Cisco Unified Communications Manager? (Choose three.)
A. manually
B. DHCP  
C. bulk import using BAT  
D. TFTP  
E. LDAP synchronization  
F. autoregistration  

Correct Answer: ACE  
Explanation/Reference:  

Question 171  
Which standard is applicable to prevent an unnecessary drop in QoS over an IP WAN connection?  
Which standard is applicable to prevent an unnecessary drop in QoS over an IP WAN connection?  
A. TCP/IP  
B. broadband Internet access  
C. H.450.3  
D. policy map  

Correct Answer: C  
Explanation/Reference:  

Question 172  
Which two options allow the maximum message length to be adjusted in Cisco Unity Connection?  
Which two options allow the maximum message length to be adjusted in Cisco Unity Connection? (Choose two.)  
A. Message Settings under individual users  
B. User Templates > VoiceMail/serTemplate > Message Settings  
C. Contacts > Message Settings  
D. Enterprise Parameters > Maximum Message length  
E. Service Parameters > Voicemail Settings  

Correct Answer: AB  
Explanation/Reference:  

Question 173  
Which option is the Cisco recommended mechanism for delivering voice payload?  
Which option is the Cisco recommended mechanism for delivering voice payload?  
A. IntServ  
B. Diffserv  
C. policing  
D. shaping  

Correct Answer: B  
Explanation/Reference:  

Question 174  
Which service allows the network to provide better or special services to a set of users and applications at the expense of other users and applications?  
Which service allows the network to provide better or special services to a set of users and applications at the expense of other users and applications?  
A. QoS  
B. dial plans  
C. route patterns  
D. dial peers  

Correct Answer: A  
Explanation/Reference:  

Question 175  
Which two choices best describe call signaling and media flows?  
Which two choices best describe call signaling and media flows? (Choose two.)  
A. a process used to connect two parties calling  
B. audio or video or both transferred between two parties during conversation  
C. protocol for end-to-end users  
D. a flow of audio and instant messaging  
E. all call control signals being delivered through a channel  
F. data telephony, over a data network such as the Internet  

Correct Answer: AB  
Explanation/Reference:  

Question 176  
Which protocol allows Cisco Unified Communications Manager to take control of a specific port on a gateway?  
Which protocol allows Cisco Unified Communications Manager to take control of a specific port on a gateway?  
A. SIP  
B. H.323  
C. Q.931  

Correct Answer: A  
Explanation/Reference:
Question 177
Which protocol is used between two Cisco IP phones once Cisco Unified Communications Manager Express connects a call?
A. H.323
B. RTP
C. SCCP
D. SIP
Correct Answer: B
Explanation/Reference:

Question 178
Which standard protocol is utilized for signaling between the Cisco Unified Communications Manager Express router and the Cisco Unity Express module?
A. SCCP
B. HTEMS
C. SIP
D. XCP
Correct Answer: C
Explanation/Reference:

Question 179
Which industry standard method does Cisco Unified Presence incorporate for communication between different IM clients?
A. Jabber XCP
B. Jabber XML
C. Jabber TCP
D. Jabber TLS
Correct Answer: A
Explanation/Reference:

Question 180
Which Cisco Unified Communications platform is being utilized?
Refer to the exhibit.
A. Cisco Unified Communications Manager Express
B. Cisco Unified Presence
Question 181
When should this device be configured?
Refer to the exhibit.

The exhibit shows a partial screen shot for a Cisco Unified Personal Communicator device. When should this device be configured?
A. when configuring the Service Advertisement Framework feature for Call Control Discovery
B. when Cisco Unified Personal Communicator is used in desk-phone mode
C. when Cisco Unified Personal Communicator version 7.0 is used in soft-phone mode
D. when Cisco Unified Personal Communicator version 8.0 is used in soft-phone mode
E. when Cisco Unified Personal Communicator version 8.0 is used in desk-phone mode

Correct Answer: C
Explanation/Reference:

Question 182
Which type of packet-oriented network has the characteristic of being drop-tolerant and delay-insensitive?

Which type of packet-oriented network has the characteristic of being drop-tolerant and delay-insensitive?
A. data
B. voice
C. video
D. converged
E. All packet-oriented networks share these characteristics.

Correct Answer: A
Explanation/Reference:

Question 183
What is the cause of this issue?
An administrator is attempting to add a new IP phone to the network. The phone does not register and continues to cycle through the registration process. The administrator checks and notices that the IP address assigned to the phone is not in the correct network. What is the cause of
this issue?
A. The TFTP server is misconfigured.
B. The DHCP server is giving out false IP addresses.
C. The Cisco Unified Communications Manager is down.
D. The switch port that the phone is connected to is configured with the wrong voice VLAN.
E. The PSTN gateway is down.

Correct Answer: D
Explanation/Reference:

Question 184
Which of these conditions will the key server retransmit the rekey messages?
With GETVPN, if a key server is configured to use multicast as the rekey transport mechanism, then under which of these conditions will the key server retransmit the rekey messages?
A. It never retransmit the rekey messages
B. it only retransmit the rekey message when it does not receive the rekey acknowledgment from at least one group member
C. it only retransmit the rekey message when it does not receive the rekey acknowledgment from all group member
D. it only retransmit the rekey message when DPD to the group members fails
E. it always retransmit the rekey message

Correct Answer: E
Explanation/Reference:

Question 185
Which four characteristics are associated with video? (Choose four)
A. greedy
B. TCP retransmits
C. UDP priority
D. delay sensitive
E. drop sensitive
F. benign
G. bursty

Correct Answer: ACDG
Explanation/Reference:

Question 186
Which file format is valid for this operation?
An administrator wants to import users using the Bulk Administration menu in Cisco Unified Communications Manager Administration. Which file format is valid for this operation?
A. .PDF
B. .DOC
C. .DOCX
D. .CSV
E. .XLS

Correct Answer: D
Explanation/Reference:
Explanation:
CSV is the format in which administrator can import users using the Bulk Administration menu in Cisco Unified Communications.

Question 187
Which location is Cisco Unified Presence enabled for a specific user in Cisco Unified Communications Manager?
Which location is Cisco Unified Presence enabled for a specific user in Cisco Unified Communications Manager?
A. User Administration
B. Application
C. Advanced Features
D. Capabilities Assignment
E. on the IP phone

Correct Answer: D
Explanation/Reference:
Explanation:
Capabilities Assignment allows system administrators to enable the Cisco Unified Presence (CUP) and Cisco Unified Personal Communicator (CUPC) capabilities for users. You must ensure that licenses for CUP and CUPC are available.

Question 188
Which option can rectify this issue?
Refer to the exhibit.
The error message was displayed when the administrator attempted to set the default user password in the user template to four digits long. Which option can rectify this issue?

A. The minimum password length in Cisco Unity Connection should be at least five digits long.
B. The password length needs to be configured under the Authentication Rules settings using the Minimum Credential Length configuration field.
C. The password length needs to be configured under the user template settings using the Minimum Credential Length configuration field.
D. The password length cannot be adjusted under the user template; the password length can only be adjusted under the individual users.

Correct Answer: B

Explanation/Reference:
A minimum length requirement (as set on the Edit Authentication Rule page, in the Minimum Credential Length field)
• Inclusion of at least one character from each of the following categories: upper-case letter, lowercase letter, number, and symbol (~ ! # $ % ^ & * " ’ , . : ; ? – _ ( ) [ ] < > { } + = / |)
• No characters repeated consecutively more than three times (for example, aaaaB1C9 is invalid)
• No inclusion of the alias or name of the administrator

Question 189
How can an administrator determine which codec is being used between two endpoints while a call is in progress?
A. Run the codec trace in Cisco Unified Communication Manager.
B. Use Cisco Unified Serviceability network trace.
C. Can only be seen in Cisco SDI traces.
D. Can only be seen in a sniffer trace.
E. Press the ? button twice on one of the IP phones.

Correct Answer: E

Explanation/Reference:
Pressing the button (?) twice in quick succession during an active call. The display shows you receive and transmit statistics for the call.

Question 190
What is the cause of this issue?
A user in Cisco Unified Communications Manager Administration has been added to the Standard CCM Admin Users group, which includes the Standard CCMADMIN Administration role, but the user cannot add new users. What is the cause of this issue?
A. The add user capability has been disabled for the group
B. The incorrect group and role were assigned.
C. The add user capability has been disabled for the role.
D. Only the CCMAdmin user can add users.
E. Users can be added only via LDAP

Correct Answer: C

Explanation/Reference:

Question 191
Which two options allow the maximum message length to be adjusted in Cisco Unity Connection? (Choose two.)
A. Message Settings under individual users
B. User Templates > VoiceMail/UserTemplate > Message Settings
C. Contacts > Message Settings
D. Enterprise Parameters > Maximum Message length
E. Service Parameters > Voicemail Settings

Correct Answer: AB

Explanation/Reference:

Question 192
Which situation can cause this issue?
An end user reports that they are unable to control their Cisco IP phone using Cisco Unified Personal Communicator and cannot make any calls. Which situation can cause this issue?

A. The Cisco Unified Personal Communicator is not registered in the Cisco Unified Presence server.
B. The LDAP integration is incorrect.
C. The Cisco Unified Personal Communicator is configured in desk-phone mode.
D. The Allow Control of Device from CTI checkbox in the device configuration on Cisco Unified Communications Manager is disabled.
E. The Allow Control of Device from CTI checkbox in the device configuration on the Cisco Unified Presence is disabled.

Correct Answer: D
Explanation/Reference:

Question 193
Select and Place:
Select and Place:
Question 194
Select and Place:
Select and Place:

Correct Answer:

Explaination/Reference:

Question 195
What is the preferred analog signaling method to reduce glare?
A. loop start
B. ground start

Question 196
What would be the result if a user logs into Cisco Extension Mobility using a device profile that is not subscribed to the Cisco Extension Mobility Service?
A. Normal Cisco Extension Mobility operation will occur.
B. The user will not be able to log into Cisco Extension Mobility on the phone.
C. The phone will not use the correct device profile.
D. The user will not be able to log out of Cisco Extension Mobility on the phone.
E. The phone will reboot continuously.
Correct Answer: D
Explanation/Reference:
Topic 10, Drag and Drops

Question 197
What application uses the Cisco Unified Operating System for administration and configuration?
A. Cisco Unity Express
B. Cisco Unified Messaging Gateway
C. Cisco Unified Communications Manager Express
D. Cisco Unified Presence
Correct Answer: D
Explanation/Reference:
Cisco unity is for voice mail feature. Cisco unified operating system is CUCM/CCME features.
Topic 8, Extension Mobility

Question 198
When deploying Cisco Unified Presence, which service is a basic service that can be considered as optional?
A. Cisco Unified Presence Engine
B. Cisco Unified Presence Syne Agent
C. Cisco Unified Presence Session Initiation Protocol Proxy
D. Cisco Unified Protocol Extensible Messaging Presence and Protocol Agent
Correct Answer: D
Explanation/Reference:

Question 199
Which two protocols are used by Cisco Unified Presence?
A. SIP/SIMPLE
B. XMPP
C. SCCP
D. PPPoX
E. IMPP
Correct Answer: AB
Explanation/Reference:
The Skinny Call Control Protocol (SCCP, or short Skinny) is a proprietary network terminal control protocol. PPPoX (PPP over X) designates a family of encapsulating communications protocols implementing Point-to-Point Protocol.

Question 200
Which two options are features in Cisco Unified Presence?
A. IP Phone Messenger
B. Native Presence
C. BLF speed-dial
D. Enterprise Instant Messaging
E. BLF speed-dial pickup
Correct Answer: AD
Explanation/Reference:
Question 201
Which statement about Cisco Unified Presence and LDAP is true?
A. Cisco Unified Presence must be integrated with LDAP.
B. LDAP integration is mandatory if Cisco Unified Personal Communicator is used as a client.
C. LDAP integration with Cisco Unified Presence is optional. However, user search functionality in Cisco Unified Personal Communicator will not be available.
D. LDAP integration with Cisco Unified Presence is optional. However, instant messaging functionality in Cisco Unified Personal Communicator will not be available.
Correct Answer: C
Explanation/Reference:

Question 202
Which license capability must be enabled for Cisco Unified Presence to work with a specific user?
A. Enable Cisco Unified Presence
B. Enable Cisco Unified Presence Server
C. Enable Cisco Unified Presence Communicator
D. Enable Extensible Messaging and Presence Protocol
Correct Answer: A
Explanation/Reference:

Question 203
What should the device name be?
Refer to the exhibit.

The exhibit shows a partial screen shot for a Cisco Unified Client Services Framework device. If the username that is associated with this device is jdoe, what should the device name be?
A. The device name should be JDOEUPC.
B. The device name should be UPCJDOE.
C. The device name should be JDOE.
D. The device name should be UPCCUPC.
E. The device name does not need to relate to the user ID of the user for CSF device.
Correct Answer: E
Explanation/Reference:

Question 204
Which protocol is being used when you are utilizing the chat feature of Cisco Unified Personal Communicator?
A. SIMPLE
B. SIP
C. XMPP
D. HTTPS
Correct Answer: C
Explanation/Reference:

Question 205
Which command is useful to see if network layer information is being received at a PSTN gateway?
A. show gateway status
B. show isdn q931  
C. show c cm-manager status  
D. show isdn status  
E. show isdn q921

Correct Answer: D  
Explanation/Reference:

**Question 206**  
When creating a new softphone for a Cisco Unified Presence user, which phone type should you select if you are using Cisco Unified PersonalCommunicator Release 7.1?  
When creating a new softphone for a Cisco Unified Presence user, which phone type should you select if you are using Cisco Unified PersonalCommunicator Release 7.1?  
A. Cisco Unified Personal Communicator  
B. Cisco Unified Client Services Communicator  
C. Cisco Unified Client Services Framework  
D. Cisco Unified Personal Communicator Framework  

Correct Answer: A  
Explanation/Reference:

**Question 207**  
Which mode is CTI used with Cisco Unified Personal Communicator?  
In which mode is CTI used with Cisco Unified Personal Communicator?  
A. soft-phone mode  
B. desk-phone mode  
C. IP communicator mode  
D. IP phone mode  
E. CTI mode

Correct Answer: B  
Explanation/Reference:

**Question 208**  
Which Cisco Unified Personal Communicator mode should you use when connecting via an existing IP phone?  
Which Cisco Unified Personal Communicator mode should you use when connecting via an existing IP phone?  
A. office mode  
B. deskphone mode  
C. softphone mode  
D. IP phone mode

Correct Answer: B  
Explanation/Reference:

**Question 209**  
Which action must be taken for Cisco Unified Personal Communicator clients to access Cisco Unity Connection voice mail?  
Which action must be taken for Cisco Unified Personal Communicator clients to access Cisco Unity Connection voice mail?  
A. Cisco Unity Connection must be integrated with LDAP.  
B. Cisco Unity Connection must be integrated with Cisco Unified Communications Manager using SIP integration.  
C. A Microsoft Exchange mailbox store must be configured in Cisco Unified Presence.  
D. IMAP must be enabled on Cisco Unity Connection for users that need to access voice mail through Cisco Unified Personal Communicator clients.  
E. Voice mail is automatically enabled for users who log in through Cisco Unified Personal Communicator clients.

Correct Answer: D  
Explanation/Reference:

**Question 210**  
What protocol is being used to send and receive instant messaging between the Cisco Unified Personal Communicator and Cisco Unified Presence?  
Refer to the exhibit.

What protocol is being used to send and receive instant messaging between the Cisco Unified Personal Communicator and Cisco Unified Presence?  
A. Enterprise Instant Messaging Protocol  
B. Extensible Messaging and Presence Protocol

C. SIP  
D. SCCP  
E. CTI

Correct Answer: B
Explanation/Reference:
Explanation:
Cisco Unified Presence consists of many components that enhance the value of a Cisco Unified Communications system. The main presence component of the solution is the Cisco Unified Presence server, which incorporates the Jabber Extensible Communications Platform and supports SIP/SIMPLE and Extensible Messaging and Presence Protocol (XMPP) for collecting information regarding a user’s availability status and communications capabilities.

Question 211
When should this device be configured?
Refer to the exhibit.

The exhibit shows a partial screen shot for a Cisco Unified Client Services Framework device. When should this device be configured?
A. when configuring the Service Advertisement Framework feature for Call Control Discovery  
B. when Cisco Unified Personal Communicator is used in desk-phone mode  
C. when Cisco Unified Personal Communicator version 7.0 is used in soft-phone mode  
D. when Cisco Unified Personal Communicator version 8.0 is used in soft-phone mode  
E. when Cisco Unified Personal Communicator version 8.0 is used in desk-phone mode

Correct Answer: D
Explanation/Reference:

Question 212
what should the device name be?
Refer to the exhibit.

The exhibit shows a partial screen shot for a Cisco Unified Personal Communicator device. If the username that is associated with this device is jdoe, what should the device name be?
A. The device name should be JDOEUPC.  
B. The device name should be UPCJDOE.  
C. The device name should be JDOE.  
D. The device name should be UPCCUPC.  
E. The device name should be UPCCSF.  
F. The device name has no naming convention.
Correct Answer: B
Explanation/Reference:

**Question 213**
Which generating QoS reports CAR tool, what two parameters are valid for report generation?
Which generating QoS reports CAR tool, what two parameters are valid for report generation? (Choose two)
A. route lists
B. route patterns/hunt pilots
C. route groups
D. gateway types
E. partitions
F. IP phone directory numbers

Correct Answer: BD
Explanation/Reference:

**Question 214**
What is the accepted maximum limit for good-quality voice connection delay?
What is the accepted maximum limit for good-quality voice connection delay?
A. 100 ms
B. 200 ms
C. 250 ms
D. 300 ms

Correct Answer: C
Explanation/Reference:

**Question 215**
Which three characteristics are associated with voice?
Which three characteristics are associated with voice? (Choose three.)
A. greedy
B. TCP retransmits
C. UDP priority
D. delay sensitive
E. drop insensitive
F. benign
G. benign or greedy

Correct Answer: CDF
Explanation/Reference:

**Question 216**
What are the two differences between the IntServ and DiffServ models of QoS?
What are the two differences between the IntServ and DiffServ models of QoS? (Choose two.)
A. DiffServ provides absolute QoS guarantees.
B. IntServ is the default QoS mechanism for all routers, because applications signal the router with the QoS level they require.
C. DiffServ inherits the connection-oriented approach from telephony network design. Every individual communication must explicitly specify its traffic descriptor and requested resources to the network.
D. With IntServ, packet delivery is guaranteed. However, the use of IntServ can severely limit the scalability of a network.
E. DiffServ was designed to overcome the limitations of both the best-effort and IntServ models and can provide an “almost guaranteed” QoS.

Correct Answer: DE
Explanation/Reference:

**Question 217**
Which three characteristics are associated with data?
Which three characteristics are associated with data? (Choose three.)
A. Greedy
B. TCP retransmits
C. UDP priority
D. delay sensitive
E. drop insensitive
F. benign
G. benign or greedy.

Correct Answer: BEG
Explanation/Reference:

*Data traffic always acknowledge TCP packets for confirm delivery E2E. It is not drop sensitive because it's not real time traffic.*

**Question 218**
Which type of single switch port can support data and voice VLANs and is recommended for Cisco Unified IP phones?
Which type of single switch port can support data and voice VLANs and is recommended for Cisco Unified IP phones?
A. multiflex port  
B. trunk port  
C. access port  
D. ISL trunking port  

Correct Answer: C  
Explanation/Reference:  
Explanation:  
A port on a Cisco switch is either an access port or a trunk port. Access ports belong to a single VLAN and do not provide any identifying marks on the frames that are passed between switches.

Question 219  
When generating QoS reports in the CAR tool, what two parameters are valid for report generation?
A. route lists  
B. route patterns/hunt pilots  
C. route groups  
D. gateway types  
E. partitions  
F. IP phone directory numbers  

Correct Answer: BD  
Explanation/Reference:  

Question 220  
Which issue does CAS signaling on a T1 circuit create?
A. Signaling bits are subtracted from each frame, which causes a significant loss of voice quality.  
B. An extra signaling bit is added to the sixth frame to carry signaling information.  
C. A signaling bit is subtracted from every sixth frame to carry signaling information.  
D. Signaling bits are added to the signaling stream to create extended super frames.  

Correct Answer: C  
Explanation/Reference:  
Explanation:  
Each T1 channel carries a sequence of frames. These frames consist of 192 bits and an additional bit designated as the framing bit, for a total of 193 bits per frame. Super Frame (SF) groups twelve of these 193 bit frames together and designates the framing bits of the even numbered frames as signaling bits. CAS looks specifically at every sixth frame for the timeslot’s or channel’s associated signaling information.

Question 221  
When the engineer plugs the IP phone into the network, the phone does not power up. What is the first thing that should be checked?
A. Power over Ethernet switch  
B. Cisco Unified Communications Manager Server  
C. Cisco Unified Presence  
D. DHCP server  

Correct Answer: A  
Explanation/Reference:  

Question 222  
When you reset an IP phone via the Cisco Unified Communications Manager Administration page, which method briefly shuts down a registered phone and brings it back up?
A. drop  
B. restart  
C. reset  
D. shutdown  
E. shut and no shut  

Correct Answer: B  
Explanation/Reference:  

Question 223  
What happens if the user of the first phone is using the line and the user of the second phone uses the Barge feature?
If two phones share a line between them, what happens if the user of the first phone is using the line and the user of the second phone uses the Barge feature?
A. The user of the first phone is notified of the Barge request.  
B. A three-way conference begins.  
C. The call is discontinued, but the first phone user and the second phone user are able to talk.  
D. The user on the first phone is knocked off the line, and the second phone user takes over the line.
Question 224
What should the user do to have the call redirected to his or her phone?
A user exists within an office of IP phones, all of which have the same pickup group. A call comes into a phone of another office worker who is currently at lunch. What should the user do to have the call redirected to his or her phone?
A. Press the “Pickup” softkey and then the line that is ringing.
B. Press the “Call Pickup” softkey only.
C. Press the “Call Pickup” softkey and then the line that is ringing.
D. Press the “Pickup” softkey only.
Correct Answer: D
Explanation/Reference:

Question 225
Which calling search space is used?
An IP phone has a line calling search space and a device calling search space. If a call is made from the IP phone, which calling search space is used?
A. Neither calling search space is used.
B. The line calling search space takes precedence and is used.
C. The device calling search space takes precedence and is used.
D. The line and device calling search spaces are combined and the line calling search space has precedence.
Correct Answer: D
Explanation/Reference:

Question 226
Which type of server is used to deliver the configuration to an IP phone?
A. TFTP
B. DHCP
C. FTP
D. Cisco Discovery Protocol
Correct Answer: A
Explanation/Reference:

Question 227
Which two ways can an administrator reset an IP phone that is registered with Cisco Unified Communications Manager?
In which two ways can an administrator reset an IP phone that is registered with Cisco Unified Communications Manager? (Choose two.)
A. Phone can be reset in Cisco Unified Communications Manager Administration.
B. Phone can be reset in the Cisco Unified Communications Manager Express CLI.
C. Press the ** # * * key combination on the IP phone keypad.
D. Enter the reset ephone command in the switch.
E. Press the ** * * key combination on the IP phone keypad.
F. Press the ## ** # key combination on the IP phone keypad.
Correct Answer: AC
Explanation/Reference:

Question 228
What is the cause of this issue?
An administrator is attempting to add a new IP phone to the network. The phone does not register and continues to cycle through the registration process. The administrator checks and notices that the IP address assigned to the phone is not correct network. What is the cause of this issue?
A. The TFTP server is reconfigured
B. The DHCP server is giving out false IP addresses
C. The Cisco Unified Communication Manager is down
D. The switch port that the phone is connected to is configured with the wrong voice LAN
E. The PSTN gateway is down
Correct Answer: D
Explanation/Reference:

Question 229
Can an IP phone be configured so that calls to that IP phone can be rerouted if the IP phone become unregistered?
Can an IP phone be configured so that calls to that IP phone can be rerouted if the IP phone become unregistered?
A. Yes, configuring call forward All provides this coverage
B. No, if a phone is unregistered, the reorder tone is played to the caller
C. Yes, configuring Call Forward Busy Internal provides this coverage
Correct Answer: C
Explanation/Reference:
D. Yes, configuring Call Forward Unregistered provides this coverage
E. No, the call is dropped at the gateway

Correct Answer: D
Explanation/Reference:

**Question 230**
Where is the best place to start troubleshooting this issue?
Refer to the exhibit.

The user of IP phone A has opened a trouble ticket stating that he cannot call IP phone B. Where is the best place to start troubleshooting this issue?
A. IP phone B
B. the Cisco Unified Communication Manager system in site A
C. IP phone A
D. IP phone A user
E. the local VoIP voice gateway of IP phone B
F. IP phone B user

Correct Answer: D
Explanation/Reference:

**Question 231**
Which two purposes is the Display parameter designed to be used?
On an IP phone line appearance, for which two purposes is the Display parameter designed to be used? (Choose two.)
A. display a number other than the directory number of the IP phone
B. display a name instead of the directory number of the IP phone
C. internal caller ID
D. external caller ID
E. full directory number ID for outgoing calls

Correct Answer: BC
Explanation/Reference:

**Question 232**
When adding an IP phone to a Cisco Unified Communications Manager system, what two choices does an administrator have to add the phone to the system?
When adding an IP phone to a Cisco Unified Communications Manager system, what two choices does an administrator have to add the phone to the system? (Choose two.)
A. auto-registration
B. FHSS provisioning
C. IP phone configuration assistant
D. manual provisioning
E. Cisco Unified Serviceability

Correct Answer: AD
Explanation/Reference:
Explanations:
You can automatically add phones that support either SCCP or SIP to the Cisco Unified Communications Manager database by using
autoregistration, manually by using the phone configuration windows, or in groups with the Bulk Administration Tool (BAT). If you do not use autoregistration, you must manually add phones to the Cisco Unified Communications Manager database.

Question 233
What is the most likely cause of this issue?
All users report that when they press the Messages button on their IP phone, nothing happens. What is the most likely cause of this issue?
A. Cisco Unity Connection is not configured.
B. The default Voicemail Profile does not have a Pilot number configured.
C. The Voicemail Pilot does not have the VoiceMail Profile configured.
D. The Integrated Service Engine is offline.
E. The Voicemail Pilot is incorrect.

Correct Answer: B
Explanation/Reference:
The voice-mail pilot number specifies the directory number that you dial to access your voice messages. Cisco Unified Communications Manager automatically dials the voicemessaging number when you press the messages button on your phone. Each voice-mail pilot number can belong to a different voicemail system.

Question 234
What is the most likely cause?
After an IP phone has been added to a Cisco Unified Communications Manager server, the administrator notices that the phone has a directory number that is not in the number range in use by the organization. He also notes that the directory number is 1000. What is the most likely cause?
A. The phone number was misconfigured.
B. The phone may have auto-registered.
C. The phone is configured on another server.
D. DHCP gave the phone the wrong directory number.
E. TFTP server is misconfigured.

Correct Answer: B
Explanation/Reference:

Question 235
When troubleshooting a phone that is unable to get an IP address from a DHCP server, what is the first thing to check for on the phone?
When troubleshooting a phone that is unable to get an IP address from a DHCP server, what is the first thing to check for on the phone?
A. Make sure that DHCP Enabled is disabled on the phone.
B. Make sure that the phone is getting the proper VLAN information.
C. Make sure that the TFTP server address is correct on the phone.
D. Make sure that the DHCP scope has enough addresses left in the range.
E. Make sure the phone has the correct phone load ID.

Correct Answer: B
Explanation/Reference:
IP phones rely on a TFTP-based process to acquire configuration files, software images, and other endpoint-specific information. The Cisco TFTP service is a file serving system that can run on one or more Unified CM servers.

Question 236
Which CLI command should be in the router configuration to ensure that the IP phones are able to reach the DHCP server?
An organization is using a centralized DHCP server for all IP phones. However, when the IP phones are powered up, the phones are unable to obtain an IP address. Which CLI command should be in the router configuration to ensure that the IP phones are able to reach the DHCP server?
A. router(config)#helper-address
B. router(config-if)#ip helper-address
C. router(config-if)#ip helper-address
D. router(config)#ip helper-address

Correct Answer: B
Explanation/Reference:

Question 237
Which Cisco IOS CLI command should you use to perform an IP phone cold reboot?
Which Cisco IOS CLI command should you use to perform an IP phone cold reboot?
A. router(config-ephone)#reset
B. router(config-ephone)#restart
C. router(config-ephone)#reset
D. router(config-ephone)#reset

Correct Answer: A
Explanation/Reference:

Question 238
How does the Cisco Unified Communications Manager Express match an outbound VoIP dial peer?
How does the Cisco Unified Communications Manager Express match an outbound VoIP dial peer?
A. Outbound dial-peer matching uses the entire string of digits en bloc to match the dial peer with the longest match.
B. Outbound dial-peer matching is completed on a digit-by-digit basis.
C. It matches outbound dial peers by placing all the dial peers into a hunt group and then uses the entire dialed number en bloc to match the first dial peer.
D. Cisco Unified Communications Manager Express creates a hunt group that contains all the configured dial peers and then applies the dial digits in a digit-by-digit manner to match a dial peer.

Correct Answer: A
Explanation/Reference:
Explanation: When a router receives a voice call, it selects an outbound dial peer by comparing the called number (the full E.164 telephone number) in the call information with the number configured as the destination pattern for the POTS dial peer. The router then strips out the left-justified numbers corresponding to the destination pattern matching the called number. If you have configured a prefix, the prefix will be put in front of the remaining numbers, creating a dial string, which the router will then dial. If all numbers in the destination pattern are stripped out, the user will receive (depending on the attached equipment) a dial tone.

Question 239
Which Cisco IOS command should you use to view the configuration of voice dial peer 911?
A. show dialplan dialpeer 911
B. show dialplan number 911
C. show dial-peer voice 911
D. show event-manager consumers 911

Correct Answer: C
Explanation/Reference:

Question 240
Which device would allow you to place calls from a Cisco Unified Communications Manager that is configured with SCCP phones to a Cisco Unified Communications Manager Express that is configured with SIP phones?
A. gatekeeper
B. gateway
C. H.323 trunk
D. SIP trunk
E. Cisco Unified Border Element

Correct Answer: E
Explanation/Reference:

Question 241
Which configuration must be configured on the Cisco Unified Communications Manager Express router prior to Graphical Administration?
A. Exhibit A
B. Exhibit B
C. Exhibit C
D. Exhibit D

Correct Answer: B
Explanation/Reference:
To enable the HTTP server, and specify the path to files for the GUI and a method of user authentication for security, perform the following steps. The HTTP server on a router is disabled by default.

**SUMMARY STEPS**
1. enable
2. configure terminal
3. ip http server
4. ip http path flash
5. ip http authentication {aaa | enable | local | tacacs}
6. exit

To enable the HTTP server, and specify the path to files for the GUI and a method of user authentication for security, perform the following steps. The HTTP server on a router is disabled by default.

---

**Question 242**
Which CLI command is used in `ephone-dn` configuration mode to enable the Intercom feature to dial this phone?

A phone is configured with an ephone-dn number of A100. Which CLI command is used in `ephone-dn` configuration mode to enable the Intercom feature to dial this phone?

A. intercom extension A100  
B. intercom number A100  
C. intercom A100 enable  
D. intercom A100

Correct Answer: D

**Explanation/Reference:**

**Question 243**
Which type of ephone-dn is typically used for intercoms and paging?

Which type of ephone-dn is typically used for intercoms and paging?

A. dual-line  
B. multiline  
C. single-line  
D. special-line

Correct Answer: C

**Explanation/Reference:**

**Question 244**
Which protocol should you use to securely access Cisco Configuration Professional?

Which protocol should you use to securely access Cisco Configuration Professional?

A. HTTPS  
B. Telnet  
C. SCP  
D. TLS

Correct Answer: A

**Explanation/Reference:**

You can set up one or more lines with a shared-line appearance. A Cisco Unified Communications Manager system considers a directory number to be a shared line if it appears on more than one device in the same partition.

**Question 245**
What is the correct URL to use to add a user to Cisco Unified Communications Manager Express?

What is the correct URL to use to add a user to Cisco Unified Communications Manager Express?

A. http://ipaddress/cucme.html  
B. https://ipaddress/cue.html  
C. httpd://www.ipaddress/cme.html  
D. http://ipaddress/ccme.html  
E. http://ipaddress/cme.html

Correct Answer: D

**Explanation/Reference:**

**Question 246**
What component does Cisco Unified Communications Manager Express use to match outbound dial peers?

What component does Cisco Unified Communications Manager Express use to match outbound dial peers?

A. destination pattern  
B. incoming called-number  
C. calling number ANI  
D. answer-address  
E. port or session target

Correct Answer: A

**Explanation/Reference:**
When a router receives a voice call, it selects an outbound dial peer by comparing the called number (the full E.164 telephone number) in the call information with the number configured as the destination pattern for the POTS dial peer.

Question 247
Which reset method is the fastest to bring the phone back into service?

A. drop
B. restart
C. reset
D. shutdown
E. shut and no shut

Correct Answer: B
Explanation/Reference:
restart- Performs a fast reboot of the specified phone or all phones running SCCP associated with this Cisco Unified CME router. Does not contact the DHCP server for updated information.

Question 248
When you configure a shared extension in Cisco Configuration Professional, which two characteristics should be the same on both phones, so that the phones can successfully use a shared extension?

When you configure a shared extension in Cisco Configuration Professional, which two characteristics should be the same on both phones, so that the phones can successfully use a shared extension? (Choose two.)

A. monitor mode
B. MAC address
C. ephone-dn
D. number
E. user ID

Correct Answer: CD
Explanation/Reference:
You can set up one or more lines with a shared-line appearance. A Cisco CallManager system considers a directory number to be a shared line if it appears on more than one device in the same partition. For example, if directory number 9600 on phone A is in the partition called Dallas and on phone B is in the partition called Texas, that directory number does not represent a shared-line appearance. (Ensure the directory number 9600 for phone A and phone B are in the same partition; for example, Dallas.)

In a shared-line appearance, for example, you can set up a shared line, so a directory number appears on line 1 of a manager phone and also on line 2 of an assistant phone. Another example of a shared line involves a single incoming 800 number that is set up to appear as line 2 on every sales representative phone in an office.

You can also choose to update a directory number and have the updates apply to all devices that share the directory number.

The following information provides tips about and lists the restrictions for using shared-line appearances with Cisco CallManager.

Shared Line Tips
Use the following tips when configuring shared lines:
• You create a shared-line appearance by assigning the same directory number and route partition to different devices.
• If multiple devices share a line, each device name displays in the Associated Devices pane of the directory number in the Directory Number Configuration window in Cisco CallManager Administration.
• If you change the Calling Search Space or Call Forward and Pickup settings on any device that uses the shared line, the changes apply to all devices that use that shared line.
• To stop sharing a line appearance on a device, change the directory number or partition name for the line and update the directory number in the Directory Number Configuration window in Cisco CallManager Administration.
• In the case of a shared-line appearance, Remove From Device removes the directory number on the current device only and does not affect other devices.
• Most devices with a shared-line appearance can make or receive new calls or resume held calls at the same time. Incoming calls display on all devices that share a line, and anyone can answer the call. Only one call remains active at a time on a device.

Question 249
Which call processing agent is based on Cisco IOS software and works with ISR platforms?

A. Cisco Unified Presence Server
B. Cisco Unity Connection
C. Cisco Unified Communications Manager Express
D. Cisco Unified Communications Manager
E. Cisco Unified Contact Center Express

Correct Answer: C
Explanation/Reference:
Cisco unified presence server, unity connection, communication manager and contact center express requires appliance based system based on Cisco media convergence server (MCS), UCS (unified computing system) or VMware.

Question 250
Which report can you use to display all currently unassigned directory numbers?

A. Route Plan Report
B. Directory Number Assignment

Correct Answer: A
Explanation/Reference:

C. Unassigned Objects Report
D. IP Phone Number Assignment

Correct Answer: A
Explanation/Reference:

**Question 251**
Which two types of device can the Cisco Unified Disaster Recovery use as a backup target?
- [X] A. DVD RAM drive
- [X] C. tape device
- [ ] B. FTP server
- [ ] D. TFTP server
- [ ] E. WebDAV server
- [ ] F. SFTP server
- [ ] G. CD RAM

Correct Answer: CF
Explanation/Reference:
Cisco unified disaster recovery choose one of the following backup devices. Tape Device—Stores the backup file on a locally attached tape drive.
Network Directory—Stores the backup file on a networked drive that is accessed through an SFTP connection.

**Question 252**
Which report in Cisco Unified Reporting should you use to track the number of users with one or more phones?
- [X] A. Unified CM User Device Count
- [ ] B. Unified CM Device Distribution Summary
- [ ] C. Unified CM Table Count Summary
- [ ] D. Unified CM Data Summary

Correct Answer: A
Explanation/Reference:

**Question 253**
Which option should you use in the Cisco Unified Communications Manager End Users Configuration page to ensure that a user can use a desk phone both for calls and for Cisco Unified Presence?
- [X] B. Allow Control of Device from Cisco Computer Telephony Integration
- [ ] A. Enable Cisco Unified Presence Communicator
- [ ] C. Allow Cisco Unified Personal Communicator Integration
- [ ] D. Allow Cisco Unified Presence Control over IP Phone

Correct Answer: B
Explanation/Reference:

**Question 254**
When the engineer tries to register the IP phones, the registrations are unsuccessful. When the engineer checks one of the phones, there is no status that is shown along with the Cisco Unified Communications Manager server IP address. What is the probable cause?
- [X] B. There is no current connection with the Cisco Unified Communications Manager server.
- [ ] A. The server connection is established, but the information is encrypted.
- [ ] C. The Cisco Unified Communications Manager server is currently available.
- [ ] D. The currently receiving call-processing services are running on the phone.

Correct Answer: B
Explanation/Reference:

**Question 255**
Which statement accurately describes a calling search space?
- [X] D. a feature that defines which partitions are reachable from a device.
- [ ] A. a group of object with similar reach ability characteristics.
- [ ] B. a calling feature that finds mobile users.
- [ ] C. a toll that is used to track calls to certain numbers.

Correct Answer: D
Explanation/Reference:

**Question 256**
Which two directory services are supported by Cisco Unified Communications Manager for Lightweight Directory Access Protocol integration?
Which two directory services are supported by Cisco Unified Communications Manager for Lightweight Directory Access Protocol integration? (Choose two.)
A. Windows Active Directory 2008
B. Novell eDirectory
C. iPlanet Directory Server 4.0
D. Sun ONE Directory Server
E. Open Lightweight Directory Access Protocol 2.1

Correct Answer: AD
Explanation/Reference:

Question 257
Which command is used to determine if an MGCP gateway is registered with a Cisco Unified Communications Manager server?
A. show gateway status
B. show isdn q931
C. show ccm-manager
D. show isdn status
E. show isdn q921

Correct Answer: C
Explanation/Reference:

Question 258
Which situation are user PINs maintained by the local Cisco Unified Communications servers?
A. Only when the system is using LDAP synchronization.
B. Only when the system is using LDAP authentication.
C. Only when the system is using Global Directory.
D. PINs are always maintained by the local Cisco Unified Communications Manager servers
E. PINs are never maintained by the local Cisco Unified Communications Manager servers.

Correct Answer: D
Explanation/Reference:
Cisco Unified Communications Manager assigns the system Default Credential Policy to end user passwords, end user PINS, and application user passwords.

Question 259
What will happen if an end user is deleted from the Cisco Unified Communications Manager system?
A. The user will be removed, but the associated device and directory number will remain in the system.
B. The user and the associated device will be removed, but the directory number will become orphaned.
C. The user, the associated device, and the directory number will be removed.
D. The user will be removed, and the associated device and directory number will be automatically assigned to the administrator.
E. The user will be removed, and the associated device and directory number will be allocated to the next user added to the system.

Correct Answer: A
Explanation/Reference:

Question 260
To obtain CDR information, which application is used?
A. Cisco Unified Communications Manager Administration
B. Cisco Unified Serviceability
C. Cisco Unified Operating System Administration
D. Disaster Recovery System
E. Cisco Unified Communications Manager Call Detail Record Analysis and Reporting tool
F. Cisco Unified Reporting

Correct Answer: E
Explanation/Reference:
Cisco Unified Serviceability, a web-based troubleshooting tool, The Cisco Unified Communications Manager Administration Guide provides instructions for administering the Cisco Unified Communications Manager. CAR generates reports for Quality of Service, traffic, and billing information.

Question 261
When performing backups within Cisco Unified Communications Manager, which component stores backups on a remote SFTP server?
A. Local Agent
B. Master Agent
C. Scheduler
D. Backup Controller
Question 262
Which level of users in Cisco Unified Communications Manager CDR Analysis and Reporting generate reports for quality of service?

- A. administrators
- B. managers
- C. auditors
- D. individual users

Correct Answer: B
Explanation/Reference:

Question 263
Which web-based tool is used to access Cisco Unified Communications Manager CDR Analysis and Reporting?

- A. Cisco Unified CDR Administration
- B. Cisco Unified CM Administration
- C. Cisco Unified Reporting
- D. Cisco Unified Serviceability

Correct Answer: D
Explanation/Reference:

Question 264
In which scenario is it possible to have the same directory number configured on two different lines or phones and not be a shared line?

- A. directory number assigned to different partitions
- B. directory number assigned to the same partition
- C. directory number assigned to different calling search spaces
- D. directory number assigned to the same calling search space

Correct Answer: A
Explanation/Reference:

You can set up one or more lines with a shared-line appearance. A Cisco Unified Communications Manager system considers a directory number to be a shared line if it appears on more than one device in the same partition.

Question 265
What is the Cisco Unified Communications Manager implementation of one-way intercom referred to as?

- A. One-Way Intercom monitor
- B. Whisper Intercom
- C. Secure Intercom
- D. Silent monitor

Correct Answer: B
Explanation/Reference:

Whisper intercom means that only one-way audio exists from the caller to the called party. The called party must manually press a key to talk to the caller.

Question 266
Which protocol is used for communication between Cisco Unity Express and Cisco Unified Communications Manager Express?

- A. H.323
- B. G.711
- C. MGCP
- D. Q.931
- E. SIP

Correct Answer: E
Explanation/Reference:

Question 267
In Cisco Unified Communications Manager Native Presence, what two things is a watcher monitoring in real time? (Choose two.)

- A. Registration status of a specific IP phone
- B. Registration status of the hunt group
- C. Registration status of the MGCP gateway
- D. Registration status of Cisco Extension Mobility of the IP phone

E. Status of a registered directory number

Correct Answer: AE
Explanation/Reference:
Explanation:
When you configure Presence in Cisco Unified Communications Manager Administration, an interested party, known as a watcher, can monitor the realtime status of a directory number or SIP URI, a presence entity, from the device of the watcher.
Cisco Unified Communications Manager controls which destinations a watcher can monitor using presence groups. A presence group contains watchers and the destinations that can be monitored by the watchers in the group. To allow watchers in one group to monitor directory numbers in other groups, you specify permission settings to allow or block (disallow) the presence request. Presence authorization works with the presence groups that are configured to ensure that a watcher has permission to monitor the status of a destination.

Question 268
What CAR tool feature would the administrator use?
An administrator wants to see how long a specific IP phone extension is in use during a given period of time. What CAR tool feature would the administrator use?
A. System Reports > Traffic > Summary by Phone Number
B. CDR > Search > By Call Precedence Level
C. Device Reports > Route Patterns/Hunt Groups > Route and Line Group Utilization
D. User Reports > Top N > By Duration

Correct Answer: A
Explanation/Reference:
Explanation:
Only CAR administrators generate the Traffic Summary by Phone Number report. The report provides information about the call volume for a period and set of phone numbers that you specify.

Question 269
What is the quickest way to test the Cisco Unified Communications Manager configuration part of MWI to see if MWI On and MWI Off is working?

A. Dial into Cisco Unity Connection from an IP phone. Enter the MWI On numbers, then enter the MWI Off numbers.
B. Call a voice-mail user and ask them if their MWI light is on, and then disconnect the call. Call the user back and ask if the MWI light is off.
C. In Unity Connection, issue the MWI Flash command to turn all MWI lights on, then off.
D. If MWI numbers are dialable from an IP phone, dial the MWI On number. If the light comes on, then dial the MWI Off number to see if the light goes off.
E. MWI cannot be tested directly from the Cisco Unified Communications Manager or an IP phone.

Correct Answer: D
Explanation/Reference:

Question 270
Which two locations can an end user configure their Call Forward All settings?
In which two locations can an end user configure their Call Forward All settings? (Choose two.)
A. Cisco Unified Serviceability
B. Cisco Unified Communications Manager User Options Interface
C. Directly on the Cisco Unified IP phone
D. Cisco Unified Communications Manager Administration
E. Cisco Unified User Serviceability

Correct Answer: BC
Explanation/Reference:
Explanation:
Cisco Unified Serviceability, a web-based troubleshooting tool. Cisco unified communication manager administration comprise all the features.

Question 271
Which report can be generated by using the User Reports feature of the CAR tool?
Which report can be generated by using the User Reports feature of the CAR tool?
A. Traffic
B. Top N
C. Malicious Call Details
D. CDR Error
E. FAC/CMC

Correct Answer: B
Explanation/Reference:
Explanation:
Users, managers, and CAR administrators can generate user reports. CAR includes the following user reports: Bills, Top N, FAC/CMCC, CDR error and malicious call details are system report.

Question 272
What Cisco client application allows administrators to interact with performance monitoring counters to assist in determining the overall health of the Cisco Unified Communications Manager server?
What Cisco client application allows administrators to interact with performance monitoring counters to assist in determining the overall health of the Cisco Unified Communications Manager server?
A. Cisco Unified Communications Manager Administration
B. Cisco Unified Real-Time Monitoring Tool  
C. Cisco Unified OS Administration  
D. CAR Tool  
E. BAT Tool  

Correct Answer: B  
Explanation/Reference:  
Cisco Unified Communications Manager Administration Guide provides instructions for administering the Cisco Unified Communications Manager.  
Cisco Unified Communications Operating System Administration allows you to configure and manage the Cisco Unified Communications Operating System.  
CAR denotes CDR analysis and reporting tool, The Cisco Unified Communications Manager Bulk Administration Tool (BAT), a web-based application, performs bulk transactions to the Cisco Unified Communications Manager database. BAT lets you add.

**Question 273**  
What could be the cause of this issue?  
A new phone has been added to the Cisco Unified Communications Manager server. The phone display shows Your Current Options, but when the NewCall softkey is pressed, no dial tone is heard and the call cannot be placed. What could be the cause of this issue?  
A. An incorrect MAC address has been entered for the new phone.  
B. No directory number has been assigned to a line.  
C. The end user is not associated with the device.  
D. No calling search space has been configured on the line.  
E. An incorrect device pool has been configured on the phone.  

Correct Answer: B  
Explanation/Reference:  
A Cisco Unified CME system uses the following basic building blocks:  
• Ephone or voice register pool – A software concept that usually represents a physical telephone, although it can also be used to represent a port that connects to a voice-mail system, and provides the ability to configure a physical phone using Cisco IOS software. Each phone can have multiple extensions associated with it and a single extension can be assigned to multiple phones. Maximum number of phones and voice register pools supported in a Cisco Unified CME system is equal to the maximum number of physical phones that can be connected to the system.  
• Directory number – A software concept that represents the line that connects a voice channel to a phone. A directory number represents a virtual voice port in the Cisco Unified CME system, so the maximum number of directory numbers supported in Cisco Unified CME is the maximum number of simultaneous call connections that can occur. This concept is different from the maximum number of physical lines in a traditional telephony system.

**Question 274**  
What is the cause of this issue?  
A user in Cisco Unified Communications Manager Administration has been added to the Standard CCM Admin Users group, which includes the Standard CCMADMIN Administration role, but the user cannot add new users. What is the cause of this issue?  
A. The add user capability has been disabled for the group  
B. The incorrect group and role were assigned.  
C. The add user capability has been disabled for the role.  
D. Only the CCMAdmin user can add users.  
E. Users can be added only via LDAP  

Correct Answer: C  
Explanation/Reference:  
The Standard CCM Admin Users role includes no permissions beyond logging into Cisco Unified Communications Manager Administration. The administrator must add another authorization role to define the parts of the Cisco Unified Communications Manager Administration that the user can administer.

The Standard CCMADMIN Administration role allows a user to access and make changes in all of Cisco Unified Communications Manager Administration.

**Question 275**  
Where can the phone menu be accessed from?  
Refer to the exhibit.
Where can the phone menu be accessed from?
A. from the individual users or user templates
B. from the Class of Service configuration screen
C. from the user contacts
D. from the Interview Handler configuration screen
E. from the Message Store configuration screen

Correct Answer: A
Explanation/Reference:
Explanation:
Cisco Unity Connection offers several versions of the phone conversation that users hear and use. The version you select determines whether Connection responds only to phone keypad input or also uses voice recognition to interpret spoken commands.

Question 276
When implementing a plan of action, what should you do?
A. Make all of the changes at once to minimize the impact to users.
B. Limit the impact of the changes to users.
C. Completely remove access lists to ensure that they will not impact the changes.
D. Even if a change adversely affects the users, keep moving forward with the plan of action.

Correct Answer: B
Explanation/Reference:
Explanation:
Make all of the change at once is not good decision.

Question 277
Which type of user in Cisco Unified Communications Manager has an interactive login?
A. administrator
B. end user
C. application user
D. phone user

Correct Answer: B
Explanation/Reference:
Explanation:
End users — End users are associated with an individual and have an interactive login. End users can have administrative roles based on the user group role configuration.
Application users — Application users are associated with applications such as Cisco Unified Attendant Console, Cisco Unified Contact Center Express (UCCE), or Cisco Unified Manager Assistant. The mentioned applications need to authenticate with CUCM, but application users do not have the ability to interactively log in. Application users are leveraged for internal process level communications between applications.

Question 278
Which utility should you use when you need to add a large number of users into Cisco Unified Communications Manager?
A. Cisco Unified User Administration
B. Application User CAPF Profile
C. Cisco Unified Communications Manager Bulk Administration Tool
D. Cisco Unified Telephony User Administration

Correct Answer: C
Explanation/Reference:
Explanation:
The Cisco Unified Communications Manager Bulk Administration Tool (BAT), a web-based application, performs bulk transactions to the Cisco Unified Communications Manager database. BAT lets you add, update, or delete a large number of similar phones, users, or ports at the same time. When you use Cisco Unified Communications Manager Administration, each database transaction requires an individual manual operation, while BAT automates the process and achieves faster add, update, and delete operations.

Question 279
Which method is the best method to accomplish this task?
An administrator wants to locate and remove all unassigned directory numbers on the Cisco Unified Communications Manager system. Which method is the best method to accomplish this task?
A. Choose Device > Phone. Search all phones and remove the undesired directory numbers.
B. Use the Dial Plan Installer to remove the directory numbers.
C. Use the Disaster Recovery System to restore only valid directory numbers.
D. Choose Call Routing > Route Plan Report, choose the Unassigned DN drop-down menu, and then remove all orphaned directory numbers.
E. Choose Device > Device Settings > Device Defaults and use the wizard to locate and remove the orphaned directory numbers.

Correct Answer: D
Explanation/Reference:

Question 280
What is the most likely cause of this issue?
An administrator is attempting to add a new user in Cisco Unified Communications Manager Administration but does not see the option to add a new user. What is the most likely cause of this issue?
A. The SQL User database is not running.
B. The system is synchronized with an LDAP server.
C. BAT is not enabled.
D. The administrator has the ace no user add rights box checked.
E. The SIP Realm is not defined in User Management.

Correct Answer: B
Explanation/Reference:

Explanation:
If you enable LDAP synchronization in Cisco Unified Communications Manager Administration, you thereby configure your system to use the LDAP corporate directory as the end user directory for Cisco Unified Communications Manager. In this scenario, you cannot add or delete users in Cisco Unified Communications Manager Administration. You add and remove end users in the corporate LDAP directory.

Question 281
Which service should you activate in Cisco Unity Connection?
To monitor the service health and performance, which service should you activate in Cisco Unity Connection?
A. CUC Performance Service
B. CUC System Auditing
C. Real-Time Monitoring Tool
D. Cisco Serviceability Reporter

Correct Answer: D
Explanation/Reference:

Question 282
Which two fields are required parameters when manually creating users on Cisco Unity Connection with predefined templates?
Which two fields are required parameters when manually creating users on Cisco Unity Connection with predefined templates? (Choose two.)
A. Username (alias)
B. Extension
C. First name and last name
D. Employee ID
E. Title

Correct Answer: AB
Explanation/Reference:

Explanation:
Following items need to be configured when creating new user from predefined template:
User Template Type (extension), Based on Template, Alias, Display Name, Mailbox Store, Outgoing Fax Server, Phone System, Generate SMTP Proxy Address From Corporate Email Address (Cisco Unity Connection 8.5 and Later only)

Question 283
How many failed attempts at signing into Cisco Unity Connection is a user allowed before their account is locked out?
By default, how many failed attempts at signing into Cisco Unity Connection is a user allowed before their account is locked out?
A. 2
B. 3
C. 4
D. 5
E. 6
F. no limit

Correct Answer: B
Explanation/Reference:
**Question 284**
Which Cisco Unity Connection report provides a summary view of the current size, last error condition, and status of the mailbox store?

A. Users  
B. Message Traffic  
C. Mailbox Store  
D. System Configuration

Correct Answer: C

**Explanation/Reference:**

**Question 285**
Which three rules are valid transfer rules in Cisco Unity Connection? (Choose Three)

A. Standard  
B. alternate  
C. closed  
D. holiday  
E. nonstandard

Correct Answer: ABC

**Explanation/Reference:**

**Standard Transfer Rule**
This transfer rule applies during the work hours that your Cisco Unity administrator specified for your organization, or in other situations when no other transfer rule is enabled. By design, the standard transfer rule cannot be disabled.

**Alternate Transfer Rule**
Enable this transfer rule to apply during a specific time period when you want to override the other transfer rules. For example, you may want to route all your calls directly to voice mail while you are out of the office or you may want to transfer your calls to a different extension if you are temporarily working from another location. As long as it is enabled, the alternate transfer rule overrides all other transfer rules.

**Closed Transfer Rule**
Enable this transfer rule if you want Cisco Unity to perform different transfer actions during the nonwork hours that your Cisco Unity administrator specified for your organization. (For example, you may want to route all your calls directly to voice mail during nonwork hours.) As long as it is enabled, the closed transfer rule overrides the standard transfer rule during nonbusiness hours.

**Question 286**
Which option can rectify this issue?

Users report that when they press the Messages button on their phones, they often get a busy tone. Which option can rectify this issue?

A. Disable the Callers Can Edit Messages checkbox under the Message settings  
B. The CSS for the phones does not contain the voice-mail port partitions  
C. The CSS for the phone does not contain the voice-mail pilot partition.  
D. Precede all Cisco Unity Connection greetings to announce that each message is limited to 90 seconds long to free up voice-mail ports.

Correct Answer: A

**Explanation/Reference:**

When a host needs to reach a device on another subnet, the ARP cache entry will be that of the Ethernet address of the local router (default gateway) for the physical MAC address. The destination IP address will not change, and will be that of the remote host (HostB).

**Question 287**
Which statement about Cisco Unity Connection user templates is true?

A. Changes in user templates affect only new users to be created.  
B. Changes in user templates affect only existing users.  
C. Changes in user templates affect new and existing users.  
D. Changes in user templates have no impact on users unless those users are imported through Active Directory.

Correct Answer: A

**Explanation/Reference:**

Changes to the template will not affect any currently existing user accounts that were based on the template when they were created. Changes to a user template affect only those accounts that are created subsequent to the changes.

**Question 288**
Which three options are valid for creating users in Cisco Unity Connection? (Choose three.)

A. manual creation  
B. bulk using *.csv file  
C. bulk using enterprise parameters  
D. Cisco Unity Connection Serviceability  
E. automatic creation through TUI by users dialing into voice mail  
F. import through Active Directory

Correct Answer: ABF
Cisco Unity Connection Serviceability, a web-based troubleshooting tool for Cisco Unity Connection.

Question 289
When creating a Cisco Unity Connection user template, which element should you configure to automatically play a “This department is closed” message at specific hours?
A. greeting schedule
B. extension greetings
C. schedule
D. active schedule
Correct Answer: D

Question 290
Which tools allow the administrator to migrate users from Cisco Unity to Cisco Unity Connection?
A. Cisco Object Backup and Restore Application Suite
B. Cisco Disaster Recovery Framework Tool
C. Cisco Real Time Monitoring Tool
D. Cisco Unity Serviceability Tool
Correct Answer: A

Question 291
Where can this behavior be changed?
Users report that all external callers are leaving urgent voice-mail messages. Where can this behavior be changed?
A. Under the Phone Menu Configuration > Unidentified Callers Message Urgency
B. Under the Opening Greeting > Unidentified Callers Message Urgency
C. Under the Message Settings > Unidentified Callers Message Urgency
D. Under the System Call Handlers > Unidentified Callers Message Urgency
E. Under the Voice-mail Box Settings > Unidentified Callers Message Urgency
Correct Answer: C

Explanation:
Message urgency indicates the action that Cisco Unity Connection allows when a message has been left by an unidentified caller or by a user who has not explicitly signed in.